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Partnerships (1065)

THE BASICS OF DATA ENTRY FOR A PARTNERSHIP 
(1065) RETURN ARE THE SAME AS FOR THE 1040. 
NAVIGATION THROUGH DATA ENTRY, FIELD- AND 
SCREEN-LEVEL HELP, AND KEYBOARD SHORTCUTS 
ALL FUNCTION AS THEY DO IN THE 1040 PROGRAM. 
SEE THE 2018 DRAKE TAX USER’S MANUAL FOR 
THE BASICS OF USING THE PROGRAM. (THE 
MANUAL IS AVAILABLE ON THE INSTALLATION CD 
AND ON THE DRAKE SUPPORT WEBSITE: 
SUPPORT.DRAKESOFTWARE.COM > TRAINING 
TOOLS > MANUALS.)

WHAT’S NEW IN DRAKE TAX FOR PARTNERSHIP RETURNS

Drake Tax programs its tax software according to the latest IRS rules and regulations. 
The 2018 program reflects all changes to credits and deductions, including discontinu-
ations. For details on new regulations for 2018, see the IRS instructions for Form 
1065.

IMPORTANT

Be sure to review the 2018 Drake Tax User’s Manual 
– available from the Support.DrakeSoftware.com 
website – for details on the changes to the tax pro‐
gram and practice management tools, such as 
Update Manager, Scheduler, Client Status Manager, 
new security measures, such as two‐step authenti‐
cation, and enhancements to other programs, such 
as SecureFilePro and Drake Accounting.

NOTE Some of new IRS forms – and the Drake Tax screens used to 
complete these forms – were not ready in time for the publica‐
tion of this supplement.
Tax Year 2018 9



What’s New in Drake Tax for Partnership Returns Drake Tax Manual Supplement: Partnerships
Many of the changes brought about by the Tax Cuts and Jobs Act (TCJA) are 
described in the following pages.

IRS CHANGES FOR 2018
• There are now special rules for eligible gains invested in Qualified Opportunity 

Funds. Effective December 22, 2017, section 1400Z-2 provides partners investing 
eligible gains in Qualified Opportunity Funds (QOF) can “defer recognition of cer-
tain gains.” In Drake Tax, a link was added to line 26 of screen B (Schedule B 
cont. tab) to access the new screen 8996, used to complete Form 8996, Qualified 
Opportunity Funds. The partnership files Form 8996 annually to report that the 
QOF meets the investment standard of section 1400Z-2 or to figure the penalty if it 
fails to meet the investment standard. See Form 8996 and its related instructions 
for more information.

• Because many “entertainment” expenses are no longer deductible, screen DED has 
been changed. Screen DED includes two new lines, one for any deductible enter-
tainment expenses and one for nondeductible entertainment expenses. Meals are 
still 50% deductible.

• For tax years beginning after 2017, individuals, estates, and trusts may be entitled 
to a deduction of up to 20 percent of their Qualified Business Income (QBI) from a 
trade or business, including income from a pass-through entity, plus 20 percent of 
qualified real estate investment trust (REIT) dividends and qualified publicly 
traded partnership (PTP) income. Partnerships must now pass information through 
to each partner for the purpose of calculating a QBI deduction on the partner level. 
Drake Tax has included new fields and screens for reporting this income in new 
Qualified Business Income (QBI) Deduction sections on such screens as K, K1P 
K1F, and a new 199A screen. For more information, see “Passing Through QBI 
Information” on page 34.

• Effective for tax years beginning after 2017, the eligibility of small business tax-
payers to use the cash method has been expanded.

• Form 8979, Partnership Representative Revocation, Designation, and Resignation 
Form. See “Partnership Representative (formerly Tax Matters Partner)” on page 27 
for more information.

• For tax years beginning in 2018, every taxpayer who deducts business interest is 
required to file Form 8990, Limitation on Business Interest Expense Under Section 
163(j), unless an exception for filing is met. Click the 8990 link on the Other 
Forms tab of the Data Entry Menu.

• The Domestic Production Activities Deduction (DPAD) has been repealed for tax 
years beginning after 2017, with limited exceptions. See “Domestic Production 
Activities Deduction” on page 47 for more.

• The filing addresses for businesses located in certain states have changed. See item 
C, “Where to Mail Return” on the FAQ screen.

NOTE Form 8996 must be mailed. It is not eligible for e‐file. 
10 Tax Year 2018



Drake Tax Manual Supplement: Partnerships                                                                                What’s New in Drake 
• Technical termination terminated: The check box denoting a “technical termina-
tion” of a partnership has been removed from Drake Tax screen 1 and from item 
“G” on the first page of Form 1065.

• The following payments can now be made with Form 1065, and refunds of over-
payment can be claimed using the new “Tax and Payment” section on page 1 of the 
form:
– Interest due under the look-back method for the completed contract method 

and the income forecast method
– Bipartisan Budget Act of 2015 (BBA) Administrative Adjustment Request 

(AAR) imputed underpayment
– Other taxes
– Refunds of overpayments
– Modification payment made under section 6225(c)(2)

• For entering data used to calculate the “Tax and Payment” section of Form 1065, 
Drake Tax has added a new screen, TAX, available on the General tab of the Data 
Entry Menu, containing fields for adding a BBA AAR imputed underpayment 
amount, “Other Taxes,” and “Payment.” The program will generate Return Notes 
with instructions on how to make payments based on each line.

• A “beginning of year” column for nonrecourse and recourse loans was added to 
Schedule K-1, section K, “Partner’s share of liabilities.”

• New Family Medical Act credit is available in all Drake Tax packages, using new 
Form 8994, Employer Credit for Paid Family and Medical Leave. Click the 8994 
link on the Credits tab of the Data Entry Menu.

• Form 8832, Entity Classification Election, is used by a business entity to elect how 
it will be classified for federal tax purposes, as a corporation, a partnership, or an 
entity disregarded as separate from its owner. An eligible entity is classified for 
federal tax purposes under the default rules described below unless it files Form 
8832 or Form 2553, Election by a Small Business Corporation. The IRS will use 
the information entered on this form to establish the entity’s filing and reporting 
requirements for federal tax purposes. In Drake Tax, screen 8832 is available on 
the Other Forms tab of the Data Entry Menu.

• Section 951A requires U.S. shareholders of controlled foreign corporations to 
determine and include their Global Intangible Low-Taxed Income (GILTI) in tax-
able income every year. Section 951A is effective for tax years of foreign corpora-
tions beginning after 2017, and tax years of U.S. shareholders in which or with 
which such tax years of foreign corporations end. In Drake Tax, use the 8992 
screen, available on the Foreign tab of the Data Entry Menu.

• Section 965 of the Code (section 965) was amended by section 14103 of the Tax 
Cuts and Jobs Act (TCJA) requiring certain taxpayers to include in income an 
amount based on the accumulated post-1986 deferred foreign income of certain 
foreign corporations of which they are U.S. shareholders, either directly or indi-
rectly through other entities. This is reported on Form 965, Inclusion of Deferred 
Foreign Income Upon Transition to Participation Exemption System. In Drake Tax, 
use the 965 screen, available on the Foreign tab of the Data Entry Menu.

Schedule B The most extensive changes to Form 1065 this year involve Schedule B. This form has 
been expanded, with new questions, and, depending on a certain election, a new 
Schedule B-2. Drake Tax has thus added several new screens, including a Schedule B 
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cont. tab on the B screen for new questions, and a Schedule B-2 screen, used to list 
shareholders in an S corporation that is a partner in the partnership.

For details on these changes and how they affect data entry, go to “Additional Infor-
mation” on page 24.’

Other 
Changes

New on Schedule K:

– Line 6c, “Dividend Equivalent.” A dividend equivalent is generally treated as 
a dividend from sources within the United States and are reported on Forms 
1120-F, U.S. Income Tax Return of a Foreign Corporation, and 1040NR, U.S. 
Nonresident Alien Income Tax Return. 

– Two new categories were added to the “Foreign Transactions” section.
– Link to screen 199A and codes and data-entry fields for reporting QBI infor-

mation to pass through to the partners (See “Passing Through QBI Informa-
tion” on page 34 for more.)

• New section 864(c)(8) provides that gain or loss from the sale, exchange, or other 
disposition of a partnership interest by a nonresident alien or foreign corporation is 
generally effectively connected with the conduct of a trade or business in the 
United States to the extent that the person would have had effectively connected 
gain or loss had the partnership sold all of its assets at fair market value.

COMPLETING A 1065 RETURN IN DRAKE TAX

The basics of data entry for a partnership (1065) return are the same as for the 1040. 
See the 2018 Drake Tax User’s Manual for the basics of using the program, or log in 
to DrakeETC.com to view online tutorials and webinars designed to teach new users 
all aspects of data entry in Drake Tax.

UPDATING A PRIOR-YEAR RETURN IN DRAKE TAX

If you prepared a tax return in Drake Tax last year, you can update the return for the 
current year in either of three ways:

• As a single return (updated one at a time) using Last Year Data > Update Clients 
2017 to 2018 (recommended) 

• When you open the return for the first time in the 2018 program and are prompted 
to update it

• With all other returns in the program using Last Year Data > Update Clients 
2017 to 2018 (not recommended)

When you update a 1065 return that was marked as “final” the previous year, the pro-
gram informs you that the return was marked final before prompting you to proceed.

HEADER INFORMATION

Screen 1 contains fields for the general information that is printed in the top section of 
page 1 of Form 1065.
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NAME AND ADDRESS

Use screen 1 to complete the partnership name and address section of Form 1065. For 
state purposes only, if the partnership has an alternate address (such as a P.O. box), 
you can enter it in the Address Line 2 field at the bottom of screen 2. 

Screen Code: 2 Access screen 2 from the States Info link on screen 1 or from the States tab of the 
Data Entry Menu.

“Doing 
Business As” 

Whatever is typed into the DBA field of screen 1 will be printed below the legal name 
of the partnership in the “Name” section of the main form (and on certain other forms, 
such as Schedule K-1).

Use of the DBA field is optional and data entered there is not required by the IRS. It is 
provided in the program for the return preparer's convenience.

The DBA can also serve as a “continuation” line for entity names that are too long to 
fit into the legal name field. Be aware, however, that not all federal forms accept data 
from a continuation (or DBA) line. For those forms, only the data entered in the legal 
name field is used.

TAX YEAR

The program uses the calendar year as the default period for all partnership returns. 
No date entries are required on screen 1 for a December 31 tax year-end.

Fiscal and 
Calendar 
Years

If the partnership uses a fiscal year (where the year begins in the current calendar year 
and ends in the next), specify the beginning and ending dates in the If not a calendar 
year section of screen 1.

52-53-Week 
Tax Year

For information on electing a 52-53-week tax year, see “Electing a 52-53–Week Year 
(Initial Return)” on page 66.

Short-Year 
Returns

A partnership may have a short-year return if changing accounting periods with IRS 
approval (Form 3115) or if this is its first or last year in business and the tax year is not 
a full year.

Screen Code: 
YEAR

Short-year return election information and 52-53-week tax year information is entered 
on the Year screen, available on the Miscellaneous tab of the Data Entry Menu or 
from a Year link on screen 1.

To enter short-year information:

1. Enter short-year dates on screen 1 in the Fiscal year beginning and Fiscal 
year ending fields, even if the firm uses the calendar year for full-year returns. 
(These dates will appear on the top of the federal form.)

NOTE Not all states recognize the use of a DBA name. Those state pack‐
ages ignore data entered in the DBA field.

NOTE The program adjusts calculations for depreciation and for gains 
and losses on sales of assets based on the entity’s tax year.
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2. Click the Year link 
(figure at right) to 
open the Year 
screen. On the Year 
screen, make your 
short-year selection 
from the Other short-year reason drop list. Type an explanation in the Expla-
nation text box. (Your explanation will be displayed at the top of the first page of 
the tax return.)

3. If you selected “General Explanation” from the Other short-year reason drop 
list, type details on the reasons for filing a short-year return in the Explanation 
text box.

For information on making elections through the ELEC screen, see “Elections” on 
page 60.

BOXES A THROUGH J
Enter most information for boxes A through J (top of Form 1065) on screen 1. Note 
that boxes D (Employer identification number), F (Total assets), I (Number of Sched-
ules K-1), and J (Schedule C and M-3 attached) are completed automatically based on 
information entered elsewhere in the program. Other boxes are:

• Box A — Principal business activity

• Box B — Principal product or service

• Box C — Business code number (Press CTRL+SHIFT+S to search activity codes)

• Box E — Date business started

• Item G — Initial, final, name change, address change, or amended return

• Item H — Accounting method (Select Cash, Accrual, or Other on screen 1; if 
Other, enter a description of the method used.)

INCOME AND DEDUCTIONS

Enter income and deductions on the INC (Income) and DED (Deductions) screens. 
INC screen amounts flow to Form 1065, page 1, lines 1a to 7. (Also see “Other 
Income (Loss)” on page 16.) DED screen amounts flow to Form 1065, page 1, lines 9 
through 20. “Other income” and “Other deductions” data is shown on attached state-
ment worksheets in View/Print mode of the return.

NOTES

• For more extensive details on entering short‐year return 
information into Drake Tax, click inside the Explanation 
text pane of the YEAR screen and press F1 to see the help.

• The program may not correctly calculate depreciation, 
gains, or losses for a short‐year return. Depreciation for a 
short‐year return can be manually entered on screen 4562 
or screens 6, 7, 8, and 9.

• For more information on short‐year returns, see IRS Pub 
4163.
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GROSS RECEIPTS

Enter gross receipts or sales and returns and allowances on the INC screen.

COST OF GOODS SOLD (FORM 1125-A)
For cost of goods sold entries, complete screen A (Form 1125-A, Cost of Goods Sold).

Inventory Inventory amounts entered on lines 1 and 7 of screen A automatically flow to Sched-
ule L, line 3, “Inventories.” Note that the Inventories fields on screen L (Schedule L 
- Balance Sheet - Assets) are overrides; entries there override inventory data from 
screen A.

Line 5, Other 
Costs

Line 5 of Form 1125-A is designated for any applicable costs not entered on the previ-
ous lines. In Drake Tax, two fields on screen A are provided for line 5: one for other 
costs including depreciation and one for other costs excluding depreciation. (See fig-
ure on next page.)

In the Other costs - depre-
ciation field, enter any 
depreciation that relates to 
the cost of goods sold 
(unless the amount is flow-
ing from the 4562 Detail 
screen with COGS selected 
from the For drop list). 

Note that this field on screen A is an override field; an entry here overrides the calcu-
lations from the 4562 screen and automatically adjusts the total depreciation that 
flows to page 1 of Form 1065. For Other costs - excluding depreciation, use a detail 
worksheet (CTRL+W). The depreciation amount is included on the statement for other 
costs and should not be included in the Other Costs detail worksheet.

Importing 
Trial Balance 
to Sch A

If using the trial balance import feature (see “Importing Trial Balance Information” on 
page 71), enter depreciation amounts directly into the appropriate fields on the trial 
balance worksheet, not in data entry. When the trial balance is imported, the COGS 
depreciation expense amount flows directly to the appropriate line of Form 1125-A 

NOTE
The IRS does not require a detail worksheet (CTRL+W) for gross 
receipts; therefore, if you are using the trial balance import fea‐
ture, do not include a detail worksheet for this line—or for any 
other line that does not require a detail worksheet.

NOTE
On screen A, items 9a through 9f are direct‐entry fields and fol‐
low the format of IRS Form 1125‐A. For more information on 
completing these fields, click in any field and press F1 or consult 
the IRS instructions.

NOTE Line 16b on the DED screen is an adjustment field for deprecia‐
tion from Form 4562 not entered on screen A.
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and is calculated accordingly. For more on depreciation and trial balance import, see 
“Depreciation” on page 78.

ORDINARY INCOME (LOSS)
Ordinary income or loss from other partnerships, estates, and trusts (line 4 of Form 
1065) flows from either screen K1P (Schedule K-1 from another partnership) or 
screen K1F (Schedule K-1 from a fiduciary).

NET FARM PROFIT (LOSS)
Screen Code: F The partnership’s net farm profit or loss (line 5 of Form 1065) flows from information 

entered on screen F (Farm Income and Expense). Farm profit or loss from other 
partnerships, estates, or trusts appears on line 4 of the return. To enter this information 
from the INC screen, click the links on line 4 to screen K1P or screen K1F. Enter the 
farm profit or loss from other partnerships, estates, or trusts on line 1 of screen K1P or 
line 6 of screen K1F. The K1P and K1F links are also on the Other Forms tab of the 
Data Entry Menu.

For information on farming partnerships with a corporation partner, see Pub. 225, 
Farmer’s Tax Guide.

NET GAIN (LOSS)
The amount on line 6 (“Net gain (loss) from Form 4797, Part II, line 17”) of Form 
1065 flows from Form 4797. Amounts can also flow from screen 4562, but only if that 
screen shows assets sold and property type.)

OTHER INCOME (LOSS)
Use the INC screen to enter amounts for the “Other income” line of the main form. 
Specific INC screen entries are displayed on attached statements in View/Print mode 
of the return.

Amounts from the following screens also flow to line 7:

• Screen 6478 — Form 6478, Biofuel Producer Credit

• Screen 8864 — Form 8864, Biodiesel Fuels and Low Sulfur Diesel Fuel Produc-
tion Credits

Additional fields on the INC screen include:

• Interest income on receivables

• Recoveries of bad debts deducted in earlier years

• Section 481 adjustments

• State tax refund (cash basis)

• Taxable income from insurance proceeds

Enter additional sources of income not listed above in the Other income (itemize) 
field. Begin typing in that field and a detail worksheet (CTRL+W) is opened with 
fields for descriptions and amounts.
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Enter other income (loss) from a partnership, estate, or trust on the K1P or K1F 
screen. (Click the links on line 4 of the INC screen.)

COMPENSATION AND WAGES

Use line 9 of the DED screen to enter wages and salaries paid. Do not include guaran-
teed payments to partners or salaries or wages reported elsewhere in the return, such 
as the amounts included in COGS, elective contributions to a section 401(k) cash or 
deferred arrangement, or amounts contributed under a salary reduction SEP agree-
ment. (Drake Tax automatically adjusts salary and wages for employment credits.)

GUARANTEED PAYMENTS AND PARTNER HEALTH INSURANCE

Use the DED and K screens to report guaranteed payments and partner health insur-
ance. Note that guaranteed payments and health insurance are entered as separate 
amounts.

Guaranteed 
Payments

To report guaranteed payments to partners:

• Enter total guaranteed payments on the DED screen, line 10.

• An entry on line 4a and 4b of screen K (Income/Loss tab) adjusts the amounts 
(adds to or subtracts from) entered on the DED screen.

• To allocate the total guaranteed payments among the partners, click the SA link to 
the right of the amount field on lines 4a and 4b of screen K (Income/Loss) tab. 
(For details on using the SA screen, see “Special Allocations” on page 32.)

Guaranteed payments should include any payments (or credits) to a partner for ser-
vices rendered. Include the use of any capital the partner provided if the payments (or 
credits) for that capital are not determined by the partnership’s income and can be 
allocated to a trade or business activity. These entries should not include any payments 
and credits that should be capitalized or any distributive shares of partnership profits.

Partner 
Health 
Insurance

To report partner health insurance:

• In the “Partner’s health insurance” field on the DED screen, line 10, enter amounts 
paid during the tax year for health insurance paid by a partnership on behalf of a 
partner for services as a partner (including a partner’s spouse or dependents or chil-
dren under age 27 who are not dependents). (See field help on line 10 of the DED 
screen for more information.)

• An entry on line 13d, item “M,” of the Deductions tab of screen K overrides the 
amount entered on the DED screen and the 8825 screen.

• To allocate the total amount of health insurance costs among the partners, click the 
SA link to the right of the amount field on line “M” of the Deductions tab of screen 
K. (For details on using the SA screen, see “Special Allocations” on page 32.)

Entries flow to boxes 4 and 13 of the partners’ Schedule K-1, to the total on line 13d 
of Schedule K, and to Form 1065, page 1, “Guaranteed payments to partners.”

For information on the partnership’s contribution to a partner’s Health Savings 
Account (HSA), see Notice 2005-8, 2005-4 I.R.B. 368.
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REPAIRS AND MAINTENANCE

Use the DED screen to enter the costs of repairs and maintenance. See Form 1065 
instructions for IRS requirements regarding costs that can be entered here.

BAD DEBTS

Use the DED screen to enter the total of all bad debts that became worthless during 
the 2018 tax year, but only if these debts related to a trade or business activity. Deduct-
ible non-business bad debts should be entered as short-term capital losses on screen 
8949.

RENTS

Use the DED screen to enter rent paid on business property used for a trade or busi-
ness activity. If the partnership rented or leased a vehicle, enter the total annual rent or 
lease expense incurred in the trade or business activity of the partnership, and then 
complete Part V of the 4562 (screens 8 and 9).

TAXES AND LICENSES

Use the DED screen to enter tax and license payment data. Amounts entered here flow 
to the “Taxes and licenses” line of Form 1065. Data is also generated on the worksheet 
“Wks Tax/Lic” in View/Print mode.

State tax amounts (income tax and franchise tax) entered on the ES (Estimated Taxes) 
screen flow to the tax computation (“Wks Tax/Lic”) worksheet. The state tax amount 
flowing from the ES screen may differ depending on which method of accounting 
(cash or accrual) is used, and which tax type is selected.

INTEREST 
The “Interest” line of Form 1065 refers only to the interest incurred by the partnership 
in a trade or business activity that is not claimed elsewhere in the return.

Use the DED screen to enter interest expense amounts. Do not include interest 
expense on the following:

• Debt required to be allocated to the production of qualified property

• Debt used to buy rental property or debt used in a rental activity

• Debt used to purchase property held for investment

• Debt proceeds allocated to distributions made to partners during the tax year

NOTE Cash‐method partnerships cannot take a bad debt as a deduction 
unless the amount was previously included in income.

NOTE Credit from Form 8846, Credit for Employer Social Security and 
Medicare Taxes Paid on Certain Employee Tips, automatically 
adjusts the amount of taxes and licenses on Form 1065.
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Self-
Charged 
Interest

Self-charged interest rules (see Form 1065 instructions) do not apply if a partnership 
elects under Reg. section 1.469-7(g) to avoid the application of them. If the partner-
ship is making this election, a statement must be included with the return.

To include the statement:

Screen Code: 
ELEC

1. Click the ELEC link on screen DED. (The ELEC screen is also available from the 
Miscellaneous tab of the Data Entry Menu.)

2. In the Election drop list, select 19 - Not Apply Alternative Treatment to 
Self-Charged Items.

When the return is calculated, the statement (“Statement EL19” in View/Print mode; 
see Figure 2-1 on page 19), including the required text, will be included in the return.

Figure 2-1: Self-Charged Interest statement

For more information on self-charged interest rules, see the “Self-Charged Interest” 
section of the Form 1065 instructions.

DEPRECIATION

Use screen 4562 to enter depreciable assets for Form 1065, Form 1125-A, Schedule F, 
Form 8825, the RENT screen (rental other than real estate), and Section 754. (To 
associate a depreciable asset with an activity, make a selection from the For drop list 
at the top of the 4562 screen.)

Using the 
DED screen 
for Direct 
Entry

As explained further in the “Line 16, Depreciation” section following, the DED 
screen has two lines for direct entry of depreciation:

• Line 16a — Depreciation

• Line 16b — Depreciation claimed elsewhere on return

NOTE Using the ELEC screen for this statement does not prevent the 
return from being e‐filed.
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Any item entered in a depreciation field on the DED screen is added to the calcula-
tions from all 4562 screens. DED screen amounts are reflected on page 1 of Form 
1065 but are not shown on any generated Form 4562.

For more information on depreciation and the 4562 screen in Drake Tax, see the 2018 
Drake Tax User’s Manual.

Line 16, 
Depreciation

Line 16c of Form 1065 is reserved for depreciation that (1) is from Form 4562 and (2) 
is claimed elsewhere. While the program pulls data from the 4562 screen for this line,

it also provides field 16b (Figure 2-2) on screen DED specifically for depreciation 
that is claimed elsewhere.

Figure 2-2: Depreciation line 16 fields from DED screen

Both lines 16a and 16b on the DED screen are adjustment fields and add to or subtract 
from program calculations that are based on entries elsewhere in the program. Enter 
only the depreciation claimed on assets used in a trade or business activity:

• Line 16a — An entry here is added to the depreciation from the 4562 screens. The 
amount on line 16a is not reflected on Form 4562.

• Line 16b — Drake Tax recommends using screen A (rather than the DED screen) 
to enter depreciation claimed on Form 1125-A. An entry in the “Other costs - 
depreciation” line on screen A adjusts any entry on line 16b of the DED screen and 
is calculated into the total deductions on Form 1065. (An entry in the Other costs - 
depreciation line on screen A also overrides calculated amounts for entries on 
4563 screens directed to COGS.) If there is an entry on line 16b of the DED screen 
but not screen A, only the line 16b amount is calculated into total deductions.

Section 754 Use screen 4562 to enter section 754 depreciation. To associate the depreciable asset 
with section 754, select “754” from the For drop list at the top of the screen.

For information on allocating Section 754 depreciation to specific partners, see “Spe-
cial Allocations” on page 32 and “Section 754 Allocations” on page 47.

IMPORTANT The depreciation fields on any screen should be used 
only if Form 4562 is not required.

NOTE Section 179 expense does not flow to page 1, “Depreciation,” of 
Form 1065. It is reflected on Schedule K, “Net long‐term capital 
gain,” and then distributed to each partner on Schedule K‐1.
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Section 179 Section 179 expense is not included on Form 4562, line 22, nor is it carried to line 16a 
of Form 1065. It is instead reflected on line 12 of Schedule K and distributed to each 
partner on Schedule K-1.

Reclassify to 
Amortization

To reclassify an asset from depreciation to amortization:

1. Open screen 4562 for the asset.
2. From the Method drop list, select AMT - Amortization.
3. Complete the applicable fields in the Amortization Information section, 

located near the bottom-left corner of screen 4562.

DEPLETION

Enter depletion amounts on the DED screen. If the partnership claims a deduction for 
timber depletion, complete and attach Form T, Forest Activities Schedules. (Attach as 
PDF to e-filed returns. See “The PDF Attachment Process” on page 68.) Do not 
deduct depletion for oil and gas properties. Depletion should be figured for each part-
ner. See “Oil and Gas Depletion Worksheet” on page 38 for more on entering oil and 
gas depletion in the 1065 package.

RETIREMENT PLANS

Use the DED screen to enter amounts for line 18, “Retirement plans, etc.” See the IRS 
instructions for guidance on what costs are acceptable for this line.

IRA for 
Employees

If the partnership contributes to an IRA for employees, include the contributions in 
salaries and wages on either the DED screen (Salaries and wages line) or screen A 
(Cost of labor line).

Payments to 
Partners

Do not use line 18 of the DED screen to deduct payments for partners to retirement or 
deferred compensation plans, IRAs, qualified plans, Simplified Employee Pension 
(SEP), or SIMPLE IRA plans. Report these amounts, which are deducted by the part-
ners on their own returns, on screen K (Deductions tab), item 13d, code R. 

EMPLOYEE BENEFIT PLANS

Use the DED screen, line 19, to enter the partnership’s contributions to employee ben-
efits programs (such as insurance, health, and welfare programs) that are not part of a 
pension or profit-sharing plan included in line 18, “Retirement plans, etc.”

NOTE The Depletion Worksheet in the Partnership package is for infor‐
mational purposes only. Depletion is calculated in the partner’s 
individual returns.

NOTE The program reduces the expense based on the credit amount 
calculated from Form 8881, Credit for Small Employer Pension 
Plan Startup Costs.
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Amounts 
Paid for 
Medical Care

The line 19 amount should not include amounts paid for insurance that constitutes 
medical care for a partner, a partner’s spouse, or a partner’s dependents. For informa-
tion on entering amounts paid for medical care, see “Guaranteed Payments and Part-
ner Health Insurance” on page 17.

Pub. 541 IRS Pub. 541 states that premiums for health insurance paid by a partnership on behalf 
of a partner for services as a partner, are treated as guaranteed payments. The partner-
ship can deduct these payments as a business expense, and the partner must include 
them in gross income. The partnership cannot deduct the premiums, however, if the 
partnership accounts for insurance paid as a reduction in distributions for that partner. 
In that case, go to the K1 screen for the partner and mark the Health Insurance dis-
tribution reduction box (line 13M) at the bottom of the screen.

A qualifying partner can deduct 100% of the health insurance as an adjustment to 
income. The partner cannot deduct the premiums for any calendar month, or part of a 
month, in which he or she is eligible to participate in any subsidized health plan main-
tained by the employer of the partner or the partner’s spouse.

OTHER DEDUCTIONS

Enter all other deductions on the DED screen. Drake Tax calculates these amounts and 
incorporates the total into the “Other deductions” line of Form 1065.

The following deductions, credits, adjustments, and exclusions also flow to the “Other 
deductions” line:

• Amortization from Form 4562, Depreciation and Amortization

• Credit adjustment from Form 6765, Credit for Increasing Research Activities

• Credit adjustment from Form 8820, Orphan Drug Credit

• Exclusion from Form 8873, Extraterritorial Income Exclusion

• Credit from Form 8941, Credit for Small Employer Health-Insurance Premiums

FILING AN EXTENSION

Generally, a domestic partnership must file Form 1065 by the 15th day of the 3rd 
month following the date its tax year ended as shown at the top of Form 1065.

Calendar year returns are due on March 15, 2019. By filing Form 7004, a partnership 
can extend the deadline six months to September 15, 2019. Fiscal-year returns are due 
on the fifteenth day of the third month after the end of the fiscal year.

To file a 1065 extension, use one of the following options:

• Go to the 7004 screen in Drake Tax (Other Forms tab of the Data Entry Menu) 
and select Generate an extension. Complete any other applicable fields on the 
screen.

• Go to the PRNT screen and select Prepare a Form 7004 extension.
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SIGNING THE RETURN

PIN signatures are required for e-filed returns. To e-file a return, complete all fields on 
the PIN screen. A return cannot be e-filed if the PIN screen is not completed, includ-
ing title and signature (name) of the general partner or LLC member manager. (See 
“‘Signs Return’ Partner,” following.) A signing date and SSN of the signing person is 
also required.

“Signs 
Return” 
Partner

If the Signs return check box was selected for one of the partners on a K1 screen, that 
partner’s title, name, SSN, and phone number will be combined with the ERO’s PIN, 
the partner’s PIN, and the signing date on the PIN screen that must still be entered on 
the PIN screen in order to e-file the return. If the Signs return check box is not 
marked on any K1 screen, then the ERO PIN, Partner PIN, Signature date, Title, 
and Signature fields on the PIN screen must be completed manually.

Preparer’s 
Signature

If the return is prepared by a paid preparer, the preparer must complete the required 
information and sign the return in the space provided on the PIN screen. If the return 
is prepared by a partner or an employee of the partnership, select NONE in the Firm # 
and Preparer # drop lists on screen 1.

To have the preparer’s signature displayed on the printed return:

• If the return preparer and ERO (entered in Setup > ERO & Account Information) 
are the same:
– Go to Setup > Preparer(s) and ensure that the Alternative Electronic Signa-

ture box is marked for the preparer.
– Enter the preparer’s PIN on the PIN screen for the return.

• If the return preparer and ERO are not the same, go to the PRNT screen and com-
plete the field labeled PIN for preparer’s alternative electronic signature. The 
PIN entered should match the one entered for the preparer in Setup > Preparer(s). 
(For more information, press F1 in this field.)

The optional Suffix drop list and Professional text box on the PIN screen allow you 
to enter such designations as “Jr.”, “Sr.”, “III” to the name of the partner and such pro-
fessional designations as “Dr.” or “Ret.”

Missing PIN
Information

If you receive a state EF Message stating, “Authentication Header,” check the SSN 
field on the PIN screen for a missing SSN. Also make sure the Title and Signature 
(name) fields for the partner signing the return are completed. (SSN is not required for 
federal returns.)

Form
8879-PE

You must receive the completed and signed Form 8879-PE, IRS e-file Signature 
Authorization for Form 1065, before the return is e-filed. This form must be kept in 
the tax office for three years from the return due date or IRS received date, whichever 
is later.

NOTE
Setup > ERO & Account Information must still be completed in 
Drake Tax for e‐file. For information on how to complete this setup 
window, see 2018 Drake Tax User’s Manual. See the IRS instruc‐
tions for further details on signature requirements.
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For information on using an electronic signature pad to digitally sign Form 8879-PE, 
see “Electronic Signatures” in Chapter 6, “Return Results,” of the 2018 Drake Tax 
User’s Manual.

AMENDING A RETURN

To file a 1065 return that has been amended:

1. Go to screen 1 in data entry and select Amended return in section G.
2. Make changes as applicable to forms and schedules.
3. Go to the EF screen and select Amended 1065 in the left-hand column.
4. Go to the SCH screen (available from the Miscellaneous tab of the Data Entry 

Menu) and complete the following fields:
• Statement number — Select 011 - Amended Return Statement.
• Title — Enter a statement title of 28 or fewer characters.
• Explanation text box — Identify the amended items by line number and 

explain what was changed and why. 

If amending just the K-1s, go to each K1 screen, select Amended K1, and make 
needed changes.

TEFRA AND FILING ELIGIBILITY

A partnership subject to the TEFRA (Tax Equity and Fiscal Responsibility Act of 
1982) audit rules cannot file an amended Form 1065 to correct a partnership item 
reported on a previously filed return, but according to these rules, the partnership rep-
resentative (PR) must file Form 8082 on the partnership’s behalf and request the IRS 
treat the Form 8082 as a substituted return. A partnership qualifying as a small part-
nership (see Section 6231(a)(1)(B)) – with 10 or fewer partners at any one time during 
the year – is exempt from the TEFRA audit rules and can file an amended Form 1065 
and corrected K-1s to partners.

ADDITIONAL INFORMATION

This section covers Schedule B (Other Information), state-specific information, and 
some program overrides.

The most extensive changes to Form 1065 this year involve Schedule B. This form has 
been expanded with new questions, and, depending on a certain election, a new 
Schedule B-2. Drake Tax has thus expanded screen B to include a Schedule B cont. 

CAUTION
When you amend a return in Drake Tax, the amended infor‐
mation replaces the original in the data file. Before amend‐
ing a return, you should archive the original to avoid losing 
previously submitted data. For more information on 
archiving returns, see “Archive Manager” in Chapter 6, 
“Return Results,” of the 2018 Drake Tax User’s Manual.

NOTE
When amending a 1065 return, all K‐1s are amended, and the 
“Amended K‐1” box on the return is marked automatically. To over‐
ride this default, go to the PRNT screen and mark Do NOT check 
amended box on Sch. K‐1.
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tab, and added the Schedule B-2 screen, used to list shareholders in an S corporation 
that is a partner in the partnership. See “Schedules B, B-1, and B-2” on page 25.

A change to the partnership representative requirements this year is that the represen-
tative must have a U.S. taxpayer ID number (TIN), and the address of the representa-
tive must be a U.S. address. See “Partnership Representative (formerly Tax Matters 
Partner)” on page 27. 

• Other changes to Schedule B include:
– Question 2, asking if any partner in the partnership was a disregarded entity, 

trust, S corporation, or an estate. This information is dealt with in subsequent 
areas of Schedule B, so it has been deleted. The remaining questions have 
been renumbered.

– Line 4c is new, allowing you to indicate that the Schedules K-1 were not fur-
nished to the partners on or before the due date of the partnership return. 
(Question 4 of Schedule B has four parts, one of which asks if the K-1s were 
furnished by the due date. You now have a way to answer that part “No,” 
while answering “Yes” to the other three parts.)

– Line 26 was added to the Schedule B cont. tab of screen B, asking if Form 
8996 is attached to certify that the partnership is a Qualified Opportunity 
Fund.

SCHEDULES B, B-1, AND B-2
New for 2018: The program now has five screens for entering data for Schedule B, 
Other Information, Schedule B-1, Information on Partners Owning 50% or More of 
the Partnership, and Schedule B-2, Election Out of the Centralized Partnership Audit 
Regime:

• B — For lines 1 through 20 (excepting lines 2 and 3)

• Schedule B cont — For lines 21 through 26 (excepting lines 2 and 3)

• B1 — For lines 2a and 2b of Schedule B-1 (foreign ownership of the partnership; 
see “Schedule B-1 Information,” below.)

• B2 — For Schedule B-2, electing out of an audit regime and listing shareholders in 
an S corporation that is a partner in the partnership (See “Electing Out of Central-
ized Partnership Audit Regime” on page 28.)

• B3 — For lines 3a and 3b of Schedule B (ownership of foreign companies by the 
partnership)

NOTE
If an entity and not an individual is selected as the partnership rep‐
resentative on a K1 screen, additional data will be required in the 
Designation of Partnership Representative section of screen B 
(Schedule B, cont. tab). 
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From screen B, you can access screens B1 and B3 by clicking the applicable links 
(Schedule B1 and Attachment 3a and 3b) or by pressing PAGE DOWN twice (for 
screen B1) or three times (for screen B3).

SCHEDULE B-1 INFORMATION

To save data-entry time, instead of selecting partners, type of entity, and country of 
organization from drop lists and then entering the percentage of owned in profit, loss, 
or capital on screen B1 screen, instead enter the required B-1 information on each 
partner’s K1 screen.

When you make a 
selection from the 
Country of Incor-
poration drop list in 
the Schedule B-1 
section (figure at 
left) of a K1 screen, 
and then make an 
entry in the Max 

Percentage Owned field, the program automatically answers questions 2a and 2b of 
Schedule B, and produces Schedule B-1, using the information entered on the K1 
screen—name, ID number, type of partner, ownership percentage—to complete Parts 
I or II (as appropriate).

Of course, you can continue to use the B1 screen if you prefer.

Foreign 
Ownership

If the partnership owned, directly, an interest of 20% or more, or owned, directly or 
indirectly, 50% or more of the total voting power of all classes of stock entitled to vote 
of any foreign or domestic corporation, use the Line 3a section of screen B3 to enter 
the corporation’s name, EIN, country of incorporation, and percentage owned in vot-
ing stock. (From the B screen, click the Attachment 3a and 3b link.)

If the partnership owned, directly, an interest of 20% or more, or owned, directly or 
indirectly, an interest of 50% or more in profit, loss, or capital in any foreign or 
domestic partnership or in the beneficial interest of a trust, use the Line 3b section of 
screen B3 to enter the entity’s name, EIN, type, country of organization, and maxi-
mum percentage owned in profit, loss, or capital.

Line 4 
Require-
ments

If question 4 on screen B is answered Yes, Schedules L, M-1, M-2, and Section L of 
Schedule K-1 are not required and therefore not printed. The four conditions that must 
be met in order to answer Yes to this question are:

NOTE Much of the Schedule B-1 information flows from entries on each 
partner’s K1 screen. See “Schedule B-1 Information,” following.

NOTE Which screens are required depends on the percentage owned. 
See Form 1065 instructions for calculating the maximum per‐
centage owned.
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• The partnership’s total receipts for the tax year were less than $250,000.

• The partnership’s total assets at the end of the tax year were less than $1,000,000.

• Schedules K-1 are filed with the return and furnished to the partners on or before 
the due date (including extensions) for the partnership return.

• The partnership is not filing and is not required to file Schedule M-3.

New for 2018: The 4c check box on screen B now allows you to indicate that the 
Schedules K-1 were not furnished to the partners on or before the due date of the part-
nership return while answering “Yes” to the other three parts.)

For more on line 4, see “Schedule L (Balance Sheets Per Books)” on page 49.

PARTNERSHIP REPRESENTATIVE (FORMERLY TAX MATTERS PARTNER)
Due to changes in IRS audit rules, partnerships must appoint a “partnership represen-
tative,” replacing the Tax Matters Partner (TMP). Unlike the TMP, the partnership 
representative (PR) does not have to be a partner in the partnership. The PR does have 
to be possess a U.S. taxpayer ID number (TIN), and the address of the representative 
must be a U.S. address. This information is entered on the appropriate K1 screen (see 
the figure on the following page) or in the override fields on the Schedule B cont. tab 
of screen B.

The PR has “complete 
authority to act on behalf 
of the partnership” when 
dealing with the IRS. This 
includes legally binding 
the partnership (and there-
fore, the partners) in terms 
of audits and other IRS 
proceedings.

The Drake Tax program 
does not select a PR if one 
is not indicated on screen
K1 or the Schedule B 
cont. tab of screen B. An 
EF Message is generated, stopping e-file until a selection of a representative is made.

The same is true if more than one partner is indicated as the PR. An EF Message stops 
e-file until a single selection is made.

Indicate the person who will act as the representative using the PTR REP check box 
on screen K1 (figure above). The representative’s information is printed at the bottom 
of page 3 of Form 1065.

To change or revoke a previously selected partnership representative, click the 8979-
PR Revocation check box on the Schedule B cont. tab of screen B and complete 
Form 8979, Partnership Representative Revocation, Designation, and Resignation 
Form.
Tax Year 2018 27



Additional Information Drake Tax Manual Supplement: Partnerships
Any information entered in the override fields of the Designation of Partnership 
Representative section of the Schedule B cont. tab of screen B overrides the PR elec-
tion made on a screen K1.

ELECTING OUT OF CENTRALIZED PARTNERSHIP AUDIT REGIME

Question 25 of Schedule B asks if the partnership is electing out of the centralized 
partnership audit regime. In the past, the IRS generally conducted partnership audits 
in accordance with TEFRA, the Tax Equity and Fiscal Responsibility Act, but TEFRA 
provided no way to collect underpaid taxes at the partnership level, forcing the IRS to 
seek payment of those taxes directly from the partners. Congress then enacted the 
Bipartisan Budget Act (BBA) that allowed assessment and collection of taxes at the 
entity level.

If the answer to question 25 of Schedule B (available on the Schedule B cont. tab) is 
“Yes,” then Drake Tax generates Schedule B-2, Election Out of the Centralized Part-
nership Audit Regime, listing all partners in the partnership based on the information 
provided on the K1 screens in the program. (If any of these partners is a partnership, 
however, or if the partnership has more than 100 partners, the partnership cannot elect 
out of the centralized partnership audit regime and in ineligible to use Schedule B-2.)

Screen Code: B2 If a partner in the partnership is an S corporation, all the shareholders of that corpora-
tion must be included in Part II of Schedule B-2. Those shareholders’ names, ID num-
bers, and their “type” must be entered on the new Schedule B-2 screen (available 
through a link on the Schedule B cont. tab or from the Data Entry Menu). Each of 
these shareholders count as a partner toward the 100-partner limit for the eligibility to 
elect out of the audit regime and eligibility to use Schedule B-2.

If the answer to question 25 is “No,” Drake Tax completes the “Designation of Part-
nership Representative” section at the bottom of Schedule B automatically, based on 
the K1 screens included in the return. (Information on the partnership representative 
also can be entered on the Schedule B cont. tab of screen B.)

Eligible 
Foreign 
Entity

New for 2018: If the partner is an eligible foreign entity, one that would be treated as a 
C (1120) corporation were it a domestic entity, select the B2 - Eligible foreign entity 
check box on that partner’s screen K1. (See Figure 2-10 on page 39.) The partner will 
be labeled with the correct code in the “Type of Eligible Partner” column of Schedule 
B-2, Election Out of the Centralized Partnership Audit Regime.

NOTE
If an entity and not an individual is selected as the Partnership 
Representative on a K1 screen, additional data will be required in 
the Designation of Partnership Representative section of the 
Schedule B. cont. tab of screen B.
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STATE-SPECIFIC INFORMATION

Resident 
State

The program automatically generates a return for the partnership’s resident state. Use 
screen 2 to enter company information as it should appear on the state return. (Access 
screen 2 from the States tab, or enter 2 in the selector field and press ENTER.)

Company information includes the type of return that applies for state purposes (con-
solidated, composite, controlled group, multi-state) and state-specific dates and num-
bers for identification.

Contact 
Information

If certain contact information required for state purposes is different from that entered 
on screen 1, use screen 2 for the alternative data for registered office, principal place 
of business, “Books in care of,” and general contact information for the partnership’s 
contact person.

Other States Data for other states must be entered in state data entry. To access state data entry, 
select the States tab from the Data Entry Menu and select the desired states for state-
specific screens (or type the two-letter state code in the selector field and press 
ENTER).

Multi-State 
Appor-
tionment

Enter sales, payroll, and property factors on the APPT Multi-State Apportionment 
screen (accessible from the States tab or by entering APPT in the selector field and 
pressing ENTER). This screen (Figure 2-3 on page 30) provides one central location 
for entering all state apportionment information instead of having to open each needed 
state’s screen. 

In addition to making data input faster and easier, this feature provides two work-
sheets: a summary worksheet (“Wks SA-SUM”) that can be used for verifying input, 
and a reconciliation worksheet (“Wks SA-REC”) that ties the total of the state 
amounts to the federal return figures. These worksheets are available in View/Print 
mode.

The individual state apportionment screens are still available in Drake Tax ’18 but will 
be used to override data entered on the APPT screen.

NOTE The company information fields on screen 2 apply to the resident 
state only.
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Figure 2-3: APPT (Multi-State Apportionment) screen

APPT 
Screens

The APPT screen is opened to the Sales tab. Links at the top of this screen take you to 
the Payroll, Property, and Additional Property information tabs for each state 
selected (Figure 2-3). These screens and their uses are listed in Table 2-1.

You may enter up to four states on one APPT screen. If you need more than four 
states, press PAGE DOWN for a new APPT screen. The same state can be entered more 
than once when additional fields are needed.

Select OT Other Reconciliation from the State Selection drop list on the Sales tab 
when using the reconciliation worksheet. Not every item appearing on the federal 

NOTE
Mark the Zero Apportionment check box (Figure 2‐3) to add a 
state but not include any apportionment data. This will include the 
state on the apportionment summary worksheet (“Wks SA‐SUM”), 
available through View/Print mode.

Table 2-1: APPT Screens

Screen Information

Sales Select state; enter sales, returns and allowance, and other 
income-related information for each selected state

Payroll Enter guaranteed payments to partners, salary, wage, com-
mission, labor, and repairs amounts for each selected state

Property Enter beginning and ending amounts of common apportion-
ment factors, plus select additional apportionment factors 
from drop lists

Additional Property Select additional apportionment factors from drop lists

NOTE
The Ending amount entered on the Property and Addition Property 
screens in Drake17 became the Beginning amount for property on the 
APPT screen when the client’s return was updated in Drake Tax ’18.
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return may be subject to multi-state apportionment. When you select OT, the data 
entered becomes a reconciling adjustment amount to aid in tying to the federal return. 

Enter as much or as little detail as the states require. If a state does not require any 
information to be entered, no information flows to that state’s return.

OTHER INFORMATION AND OVERRIDES

Use screen 1 to enter the following additional information:

Resident State — If the partnership has a mailing address in one state but does busi-
ness in another, use the Resident state drop list to select the state in which the partner-
ship does business.

Drake Codes and Overrides — For information on miscellaneous codes, invoice 
numbers, and override fields, see the following sections of the 2018 Drake Tax User’s 
Manual:

– “Listing a Different Firm, Preparer, or ERO on a Return,” in Chapter 2, 
“Installation & Setup.”

– “Miscellaneous Codes,” in Chapter 5, “Return Preparation.”

Entity Name Control Override — Use this field only if your client has obtained a 
Name Control from the IRS.

SCHEDULE K (PARTNERS’ DISTRIBUTIVE SHARE ITEMS)

Use the K screens to enter data for Schedule K, Partners’ Distributive Share Items. 

Screen K is a “tabbed” screen with separate tabs (circled in Figure 2-4) for data entry 
of income, deductions, credits, AMT and basis, and other information. There is also a 
tab for Analysis of Net Income.

Figure 2-4: Screen K is tabbed (circled at the top of the screen)

Each of the tabs includes such “Other” items such as “Other” income and “Other” 
deductions, etc., allowing a detailed supplemental K-1 statement. (Figure 2-5).

NOTE Note the screen K fields are primarily adjustment fields. Press F1 
in a field to see what amounts are adjusted from elsewhere in the 
program.
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Figure 2-5: Detailed statements with Schedule K “Other” items

Special 
Allocations

Override the calculated amounts of Schedule K items on the SA (Special Allocation) 
screen, reached by clicking an SA link on screen K. Override the allocation of any of 
the items on screen K for any of the listed partners.

For example, in Figure 2-6 on page 33, the calculated allocation to the partners of 
Ordinary dividends (item #1) of $123,342, is being overridden by Dollar Amount 
(#2). As the allocations are entered in the Dollar Amount column, the program shows 
the percentage of the total that equals the dollar amount allocated (#3). The program 
also keeps a running total of the allocated amounts and the amounts yet to be allocated 
(#4). To change from allocation by dollar amount to allocation by percentages, select 
Percentage (#5).
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-

Figure 2-6: Special Allocations (SA) screen

When you click an SA link from screens K, M1, M2, M32, or M33 to make a special 
allocation, and enter an amount or percentage on that SA screen, the screen link on the 
original K, M1, M2, M32, or M33 screen changes color (Figure 2-7 on page 34), 
making it easier to find those items that have been overridden.

NOTES

• As with most of the SA links in the program, to use these SA links, you 
must first enter data on the screen, then save (close) the screen. Reopen 
the screen, and click the SA link to open the Special Allocations dialog 
box for the line you selected.

• When the return is calculated, any amounts remaining unallocated is allo
cated to the partners based on pro rata calculations of partners’ percent-
age as entered on screen K1. Enter “0” (zero) for any partner to remove 
the partner from the pro rata distribution calculation.

• Section L of the Schedules K-1 will be recalculated based on the over-
rides entered on the SA screen.
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Figure 2-7: The SA links change color to indicate entries 
were made on the SA screen

The “Other adjustments” field of Section L of the 
Schedules K-1 will be recalculated based on the 
overrides entered on the SA screen to reconcile the 
ending capital.

For more on the “Other” fields of screen M1, see 
““Other” Adjustments” on page 53.

Partners’ 
Capital 
Analysis

There are also links to the SA screen on screen M2. Use the SA screen in this instance 
to reconcile Schedule M-2, Analysis of Partners’ Capital, to the “Partner’s capital 
account analysis” in section L of Schedule K-1.

Property 
Distributions

Links to screen SA are available on screen 8825 and RENT to allow allocation of 
property or real estate rental income.

3468 
Amounts

The Special Partner Allocations for 3468 Amounts link at the top-right corner of 
screen 3468 opens screen Schedule K Line 20C for Form 3468, allowing you to allo-
cate investment credit amounts from Form 3468 to the partners.

PASSING THROUGH QBI INFORMATION

For tax years beginning after 2017, individuals, estates, and trusts that are partners in a 
partnership may be entitled to a deduction of up to 20 percent of their Qualified Busi-
ness Income (QBI) from a trade or business, plus 20 percent of qualified Real Estate 
Investment Trust (REIT) dividends and qualified Publicly Traded Partnership (PTP) 
income. The deduction is subject to multiple limitations (such as the type of trade or 
business, the taxpayer’s taxable income, the amount of W-2 wages paid with respect to 
the trade or business, and the unadjusted basis immediately after acquisition of quali-
fied property held by the trade or business) and can be taken in addition to the stan-
dard or itemized deductions.

Partnerships are not eligible for the QBI deduction; instead, they must pass the neces-
sary information through to their partners. The partnership must attach a statement to 
its Schedules K-1, separately identifying each trade or business, and using the same 
box numbers as shown on Schedule K-1, the amount of the following items:

• Section 199A QBI

• Section 199A W-2 wages

• Section 199A UBIA

• Section 1991A Qualified REIT dividends

NOTES • SA screens should not be used for entering amounts on Schedule K.

• SA screens cannot be used for any Schedule K line with a zero balance.
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• Section 1991A Qualified PTP income

• QBI allocable to qualified payments received from the specified cooperative

• Pass-through Domestic Production Activities Deduction (DPAD) under Section 
1099A(g) from a specified cooperative

So you can report this information, Drake Tax has included in the 1065 package new 
Qualified Business Income (QBI) Deduction sections on such screens as K, K1P, 
K1S, K1F, and a new screens 199A and N199. Drake Tax automatically produces the 
required statements with each partner’s Schedule K-1. 

DENOTING SPECIFIED SERVICE TRADES OR BUSINESSES

Specified service trades or businesses are generally excluded from the definition of 
qualified trade or business. If the partnership is a Specified Service Trade or Business 
(SSTB), the partner could be subject to income limitations mentioned earlier; you 
must, therefore, mark the box on screen 1 denoting that this partnership is a “Specified 
Service Trade or Business,” if appropriate.

A specified service trade or business is any trade or business providing services in the 
fields of:

Also considered an SSTB:

• Any other trade or business where the taxpayer receives fees, compensation, or 
other income for endorsing products or services, for the use of the taxpayer's 
image, likeness, name, signature, voice, trademark, or any other symbols associ-
ated with the taxpayer’s identity, or for appearing at an event or on radio, televi-
sion, or another media format

• Investing and investment management

• Trading or dealing in securities, partnership interests, or commodities

NOTE

The program automatically calculates relevant QBI information 
based on data entry. It is important that you review the calcu‐
lated results and rely on your knowledge of this client's tax sit‐
uation. The program assumes that the partnership operates as 
a single business entity and that all of the income on Form 
1065, line 22, “Ordinary business income (loss),” is Qualified 
Business Income for purposes of computing QBI deductions. If 
the amount on line 22 is from more than one trade or business, 
use screen 199A to allocate QBI, W‐2 wages paid, UBIA, REIT 
dividends, and PTP income among the separate trades or busi‐
nesses. If any of the amount on line 22 is not QBI, (for example 
investment income) use screen N199 to report that amount, 
and the W‐2 wages paid, UBIA, REIT dividends, and PTP allo‐
cated to that income.

Health Actuarial science Athletics

Law Performing arts Financial services

Accounting Consulting Brokerage services
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REPORTING SECTION 199A ITEMS

Report the Section 199A items to be passed through to the partners on screen K, in the 
fields at the bottom of the Other Information cont’d tab (Figure 2-8).

Figure 2-8: Fields for section 199A item on the Other Information cont’d tab of screen K

Screen Code: 
199A

If reporting Section 199A income, W-2 wages, or unadjusted basis, click the 199A 
link to open the Qualified Business Income Deduction screen. On that screen, if the 
partnership operates more than one business, select 1065 from the For drop list; other-
wise, select from the For drop list the screen (K1P or K1F) that this activity pertains 
to. On each screen 199A, type in the EIN and name of the business, and be sure to 
mark the Treat as a “specified service business,” where appropriate. Type the Sec-
tion 199A information in the appropriate fields. To allocate the amounts and activities 
to the various partners, click the SA links. If reporting income data from more than 
one trade or business, press PAGE DOWN to allocate the data among the separate trades 
or businesses. 

Enter other Section 199A data on the Other Information cont’d tab of screen K.

For screens 8825 (Rental Real Estate), RENT (Rental Other Than Real Estate), and F 
(Schedule F, Farm Income), select Yes or No from the QBI drop list if this activity is a 
trade or business. (This is a required field for the 2018 package. Beginning next year, 
this field will be completed automatically when the return is updated in the 2019 pack-
age.)

AGGREGATION AND PBANS

On their Individual returns, partners have the choice to “aggregate” (or combine) cer-
tain businesses into one entity for purposes of computing the Qualified Business 
Income deduction (QBID). For that to happen, the partnership must tell the partners 
which trades or businesses qualify to be aggregated. This is done by using the PBAN 
fields.

IMPORTANT
Be sure to read the field helps for all the Section 199A 
items on the Qualified Business Income Deduction 
screen and on the Other Information cont’d tab of 
screen K.

NOTE
If Form 1065 is filed with no Section 199A information in box 20 
(codes Z‐AE) of Schedules K and K‐1, the IRS will assume that no 
QBI data was generated from this partnership and will not allow 
the QBI deduction on the partner’s individual return.
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Begin on screen 1 of the 1065 program. At the bottom right corner of screen 1 is a 
field for entering a PBAN (“Potential” Business Aggregation Number).

A PBAN works just like other “grouping” numbers in Drake Tax, such as multiform 
codes and passive activity numbers. (See “Associating One Screen with Another” in 
Chapter 3 of the 2018 Drake Tax User’s Manual for more information on using multi-
form codes).

If this partnership potentially qualifies to be aggregated with any other businesses on 
this 1065 return, enter a number in the PBAN field on screen 1.

Enter this same num-
ber in the PBAN 
fields of every 
appropriate screen 
for each business on 
this return that 
potentially could be 
aggregated — 
including the 199A 
screen. (See “Reporting Section 199A Items” on page 36.) In the figure above (from 
screen 199A), this trade has been aggregated with others using PBAN “2.”

Screen Code: 
K1AG

Complete screen K1AG (available on the General tab of the Data Entry Menu) for 
each of the trades or business suggested for aggregation. Enter the proper PBAN and 
provide an explanation of the factors met that allow the aggregation in accordance 
with Regulations section 1.199A-4. Use the same PBAN for the K1AG screen as on 
the other screens of this aggregation.

Multiple trades or businesses can be aggregated into a single trade or business if they 
meet the following requirements:

• The taxpayer or a group of persons directly or indirectly own 50% or more of each 
trade or business for a majority of the tax year and all trades or businesses use the 
same tax year end.

• None of the trades or businesses is a specified service trade or business.

• The trades or business meet at least two of the following factors:
– They provide products or services that are the same or that are customarily 

offered together.
– They share facilities or share significant centralized business elements such as 

personnel, accounting, legal, manufacturing, purchasing, human resources, or 
information technology resources.

– They are operated in coordination with, or reliance upon, one or more of the 
businesses in the aggregated group.

Screen Code: 
N199

If any portion of the income or loss calculated on line 22 of Form 1065 is not trade or 
business income for QBI deduction purposes, open screen N199 (available from the 
Other Forms tab of the Data Entry Menu), and allocate the portion of the item that 
should not be included on Schedule K-1, box 20, codes Z-AD.

Multiple 
Aggrega-
tions

It is possible to have more than one distinct aggregation group. To create a second 
aggregation, use another number in the PBAN fields of the second group. On the 
K1AG screen, press PAGE DOWN and include a description of the trade or business 
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and an explanation of the factors met that allow the aggregation in accordance with 
Regulations section 1.199A-4. Use the second PBAN for this group.

Aggregated entities are listed in a statement with partners’ Schedules K-1.

Oil and Gas 
Depletion 
Worksheet

The DEPL screen is accessible from the Other Forms tab of the Data Entry Menu. 
Use the For and MFC boxes to indicate which form or schedule the deduction should 
flow to. Create a separate depletion worksheet for each oil or gas interest. (Press PAGE 
DOWN to open a fresh instance of the DEPL screen.) Enter data for cost depletion, 
percentage depletion, or for both. If data for both cost and percentage depletion is 
entered, the program does both computations and sends the one that gives the taxpayer 
the best deduction to the proper form or schedule. (Not all taxpayers have the option 
of using either method. Consult Publication 535 for additional information.)

The deductions from all of the worksheets are totaled and carried to the indicated form 
or schedule.

MULTIPLE FOREIGN TRANSACTIONS

Screen Code: KFT Information on foreign transactions are entered on a separate KFT screen, accessible 
from the Foreign tab of the Data Entry Menu or from the Schedule K Foreign 
Transaction link on the Credits tab of screen K. Through the KFT screen, you can 
report multiple foreign transactions. (Press PAGE DOWN for a new KFT screen.)

Drake Tax generates a “Foreign Transaction Statement,” shown as “WK_FTRP~” in 
View/Print mode that lists all of the partnership’s foreign transactions. Separate For-
eign Transaction Statements (K1 STM FTR) are generated for each partner, reporting 
these foreign transactions.

BUSINESS ACTIVITIES STATEMENT

A Business Activities Statement (screen BAS) allow you to break down a partner-
ship’s Schedule K items by business activity. The amounts and totals from the BAS 
screen do not flow anywhere in the partnership return but do provide statements 
(listed on View/Print mode of “Wks BAW”) you can use as a reference when transfer-
ring these amounts into the partner’s 1040 return. A K-1 statement by business activ-
ity is also provided for the partners, listed on View/Print mode of “K-1 Wks BAW.” 
(Figure 2-9 on page 39).

NOTE The Depletion Worksheet in the partnership package is for infor‐
mational purposes only. Depletion is calculated in the partner’s 
individual returns.
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Figure 2-9: A partner’s Business Activities Statement in the 1065 package

SCHEDULE K-1 FOR 1065 (PARTNER INFORMATION)

Use the K1 screen to enter data for Schedule K-1, Partner’s Share of Income, Credits, 
Deductions, etc.

Partner Type In the Type of Partner section, select the box on line G to describe the partner as 
either a General or LLC member-manager or a Limited or other LLC member 
(default is General). On line H, select either Domestic partner or Foreign partner 
(default is Domestic).

From the line I1 drop list (red circle in Figure 2-10), choose the type of partner (not 
the type of partnership). If this box is left blank, the program uses the default selection 
of Individual.

If the partner is a retirement plan (IRS, SEP, Keogh, etc.) mark the I2 check box.

Figure 2-10: K-1 Partner Type
Tax Year 2018 39



Schedule K-1 for 1065 (Partner Information) Drake Tax Manual Supplement: Partnerships
New for 2018: If the partnership is an eligible foreign entity, mark the check box (blue 
square in Figure 2-10 on page 39). See “Eligible Foreign Entity” on page 28.

OTHER PARTNER INFORMATION

Besides the PTR REP check box (see “Partnership Representative (formerly Tax 
Matters Partner)” on page 27), the Other Information section of the K1 screen offers 
a place to indicate which partner signs the return and which is the rounding partner. 
The Control number field gives you another sorting option. (See “Setting Sort Order 
of K-1s” on page 41 for more information.

Rounding 
Partner

Mark the Rounding Partner check box on screen K1 (figure below) to select which 
should be the rounding partner who receive any balancing amount on Schedule K-1 
when the return is calculated.

The Rounding Partner no longer is auto-
matically sent to the end of whatever sort 
order you’re using. If you do not make a 
selection, the program designates as the 
rounding partner the first partner you 
entered.

If you select more than one rounding part-
ner, the program generates a Return Note 
telling you that you’ve chosen more than 
one rounding partner, and also tells you 
which partners will be used as the round-
ing partner and which will be ignored.

Signs Return If the partner described on this K1 screen is the partner who signs the return for the 
partnership, mark the Signs Return check box (figure above), and a title for the sign-
ing partner in the Title for PIN Signature field (on line E of the screen). This part-
ner’s information will not have to be re-entered on the PIN screen. (The ERO PIN, 
the “sign’s return” partner’s PIN, and the Signature date fields must still be com-
pleted on the PIN screen for the return to be eligible for e-file.)

SORTING AND VIEWING SCHEDULES K-1
View a return with multiple Schedules K-1 and you will see, in the forms “tree” on the 
left side of the View/Print window (in Enhanced View), that each partner has a “K-1” 
folder containing Schedules K-1 and any other forms, worksheets, statements, and let-
ters generated for that partner.

For those who print their K-1 forms from the Sets tab in View/Print mode, click the 
Sets tab and notice that each partner has a separate folder containing all generated fed-
eral and state K-1 schedules, forms, and worksheets, making it easier to print every-
thing needed for the partner (Figure 2-11 on page 41).

Click the PLUS SIGN [+] to expand the folder to see all documents relating to that 
shareholder. Click the MINUS SIGN [-] to collapse the folder again.
40 Tax Year 2018



Drake Tax Manual Supplement: Partnerships                                                                                Schedule K-1 for 1065 
Figure 2-11: A K1 folder in the Sets tab for all forms for each partner

Setting Sort 
Order of 
K-1s

For convenience when dealing with partnerships that have a large number of partners, 
you can sort the list of Schedules K-1 by recipient’s name, ID number, ownership per-
centage, or by the Control number.

The default sort order (as seen in View/Print mode) is determined by the order in 
which the partners are entered in the program. To select a new sort order, go to the 
PRNT screen (available through the General or Miscellaneous tabs of the Data 
Entry Menu) and, from the Sort K1s by drop list, choose:

• Control – Sort by the Control number entered on each screen K1 (See “Control 
Number,” following, for more.)

• ID – Sort numerically based on SSN or EIN of the partner

• Name – Choose to sort by first or last name and individual partners will be listed 
alphabetically by the name you choose. Partners that are businesses, estates, trusts, 
and tax-exempt organizations will be listed by the first letter of the first word or 
name in the Entity name line of screen K1.

• Percentage – Sort by the partner’s ownership percentage

Control 
Number

The Control number is an optional number the preparer can use to identify and sort 
Schedules K-1. The number can contain up to five digits and decimals are allowed. 
Schedules K-1 can be sorted in View/Print mode by the control number from the 
PRNT screen.

IMPORTANT Drake Tax does not automatically “increment” the 
control number. You have to enter a unique number 
on each partner’s K1 screen.
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GRID DATA ENTRY

If you have your program set up to take advantage of grid data entry, you can easily 
enter amounts in many of the most-often used lines of a Schedule K-1. This method is 
particularly useful for partnerships with a lot of partners.

First, initiate grid data entry:

1. Return to the Drake Tax Home window.
2. From the menu bar, select Setup > Options to open the Data Entry tab.
3. Near the bottom of the left-hand column, select Use grid data entry format on 

available screens. Click OK.

Now, open a return, and from the K-1 Information section of the General tab, click 
K1 to open the data-entry grid. To make entries in the grid:

1. Select a partner and click one of the fields where you wish to enter data.
2. Type information for that partner for that column.
3. Scroll across (or press the TAB key) to see more columns and make any entries 

needed.
4. Press the DOWN ARROW to make entries for other partners.
5. To open a partner’s K1 screen and make any other entries, select the line and click 

Item Detail (or press F3).
6. To return to the grid, close the partner’s K1 screen (or press F3). 

IRS K-1 CODES

A code sheet can follow the printing of each Form 1065 K-1 to help the taxpayer inter-
pret the various codes used on Schedule K-1. To have this sheet printed with all K-1 
schedules, from the menu bar of Drake Tax’s Home window, go to Setup > Options > 
Form & Schedule Options tab and mark the Print Page 2 of Schedule K-1... check 
box. The codes can also be printed on a return-by-return basis by marking the applica-
ble box on the PRNT screen. The code sheet is also available from Tools > Blank 
Forms.

NOTES

• You can arrange the grid by ID number, by partner’s first or 
last name, by Entity name (for partners that aren’t individu‐
als), or by the amounts in the columns of the grid by clicking 
the column headers.

• Press F3 to toggle back and forth between grid data entry and a 
data entry screen.

• Right‐click the grid and choose to export to an Excel or CSV file 
or print the grid. You can also resize the font to make the grid 
easier to read.

NEW FOR 

2018
Code sheets are now displayed in View/Print forms tree as “Sched‐
ule K‐1 Code.”
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The Schedule K-1 may include asterisks with letter codes.

• An asterisk with a letter code indicates that multiple items have that code or that a 
statement is required for the code.

• An asterisk at the bottom of a group indicates that there are more items than can fit 
in the space provided for that group and a statement is attached or that the state-
ment is required (as in the case of “other” amounts).

RETURNS WITH NUMEROUS PARTNERS

For returns with a large number of partners, you have the option of deactivating calcu-
lation and printing of the K-1 schedules while working on Form 1065. This option, 
which eases the process of reconciling the 1065, is available by going to the PRNT 
screen and marking the applicable box under K-1 Items to Suppress.

PARTNER OVERRIDES

To override calculated amounts for the partners, you can either make changes on each 
K1 screen or go to one of the SA screens for partner special allocations and make all 
changes there. For more information, see “Special Allocations” on page 32.

FOREIGN ADDRESSES

If the partner has a foreign address, enter the Province/ State, Country, and Postal 
Code information in the Foreign ONLY address line of the Partner Name and 
Address Information section of screen K1 (along with the street address and city in 
the Address and City fields in section F.) Do not enter anything in the State or ZIP 
fields. Conversely, for a U.S. address, do not enter anything into the foreign address 
fields.

OWNERSHIP CHANGES

All ownership change information is entered on the OWN screen, which is available 
from the General tab of the Data Entry Menu. To use the OWN screen:

• At the top of the screen, enter the date the profit, loss, or capital interest in the part-
nership was exchanged by two or more partners. If profit, loss, and capital are all 
involved in a transaction, put the date in the Profit/Loss/Capital field only. The 
Loss and Capital date fields are override fields, provided in case the loss or capital 
dates are different.

NOTE After completing the K‐1 entries for all partners, be sure to reac‐
tivate the calculation and printing of the K‐1s from the PRNT 
screen.

NOTE The Foreign ONLY fields are locked when a return is opened. Click 
one of the fields to unlock them throughout the return. To relock 
the unused Foreign ONLY fields, close and then reopen the return.
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• In the Change in Percentages section, select the applicable partner from the drop 
list. (The drop list contains the names and ID numbers of all partners entered on a 
K1 screen).

• Enter the percentage changes in profit, loss, or capital as positive amounts for 
increases and negative amounts for decreases. (See field-level help for more infor-
mation.)

• To enter additional ownership changes, press PAGE DOWN.

Printed Data A Summary of Change in Ownership worksheet (“Wks POWN”) is generated when 
the return is viewed. The “Wks POWN” worksheet contains a list all partners and the 
ownership percentages and changes.

K-1 EXPORT

Take the following steps to export a Schedule K-1 to another return:

1. Ensure that K-1 data is entered in the exporting 1065 return and that the recipient 
return has been created in Drake Tax. (The K1P screen in the other return does 
not have to be created beforehand.)

2. In the exporting 1065 return, go to View/Print mode.
3. Click K1 Export in the View/Print mode toolbar. A list of SSNs that cannot be 

exported appears, if applicable. (The reason a K-1 is ineligible for export appears 
in the Reason column.) Click Next.

4. The Export K1s dialog box (Figure 2-12) lists all client SSNs that can be 
exported. (To prevent a Schedule K-1 in this list from being exported, remove the 
check mark to the left of it.)

Figure 2-12: SSNs ready to be exported

5. Click Export. The K-1 data now appears on the partner’s 1040 tax return.

NOTE See FAQ item “P” in the program for more information on enter‐
ing ownership‐change information.

NOTE
Basis information for individual partners should be entered in the 
1040 package in Drake Tax; this information cannot be exported 
from the 1065 package to a 1040 return. Such an import would 
override limitations and carryovers calculated in the 1040 pro‐
gram.
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The K-1 Export feature can export K-1 data from partnership or fiduciary returns into 
the K-1 “source” screens (K1P and K1F) of the 1065 package.

An Additional Entries tab (Figure 2-13) offers 40 more fields for entering additional 
K-1 item.

Figure 2-13: Additional Entries tab of K1P screen featuring
40 additional drop lists and amount fields

SUPPLEMENTAL INFORMATION

Two types of supplemental information can be added to Schedules K-1:

• Supplemental data for all K-1s in a return

• Supplemental data for a single K-1 in a return

To add supplemental information “globally” (to all K-1s) enter the information in the 
Supplemental Information block of screen K1G. Select Global Supplemental 
Statement Information from the Select Type drop list, then type in the information 
in the large text box below. The information appears in all partners’ Schedule K-1 
Supplemental Information statements.

To add supplemental information to an individual K-1 statement, open a partner’s K1 
screen and click the Supplemental Info link at the top of the screen. In the Supple-
mental Information pane (Figure 2-14 on page 46), enter information pertinent to the 
partner. The information appears in only that partner’s Schedule K-1 Supplemental 
Information statement.
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Figure 2-14: In this example, the information entered on the K1 screen appears on only
partner Amelia Carter’s Schedule K-1 Supplemental Information statement. 

ITEM M QUESTION

If the answer to Schedule K-1, item M (“Did the partner contribute property with a 
built-in gain or loss?”), is “Yes” for all partners:

1. On the PRNT screen, select Yes in the Item M on Schedule K-1 section.
2. On screen K1G, select K1M - Built in Gain Loss Statement from the drop list, 

and type any supplemental information needed in the text box below.

If the answer is “Yes” for some partners but not others, use the individual partners’ 
Item M screens to report the supplemental information. The Item M screen is 
accessed by clicking the 8805/Item M tab at the top of any partner’s K1 screen. The 
supplemental information should list each property the partner contributed, the date 
the property was contributed, and the amount of the property’s built-in gain or loss.

PARTNER’S ADJUSTED BASIS WORKSHEET

Use the Partner’s Adjusted Basis Worksheet (Basis Wks screen) to calculate a part-
ner’s new basis after increases or decreases are made to basis during the current year. 
A partner’s adjusted (outside) basis refers to the partner’s investment in a partnership. 
The basis is determined without considering any amount shown in the partnership 
books as capital, equity, or similar account. When a partner disposes of an interest in a 
partnership, the difference between the sale price and the adjusted basis is the taxable 
gain or loss.

NOTE
Basis information for individual partners should be entered in the 
1040 package in Drake Tax; this information cannot be exported 
from the 1065 package to a 1040 return. Such an import would 
override limitations and carryovers calculated in the 1040 pro‐
gram.
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The Basis Wks screen is accessible by clicking the Basis Wks tab at the top of the K1 
screen for a partner. (Access the K1 screen from the Data Entry Menu.)

Annual 
Update of 
Partner 
Information

When the program is updated in 2019, the 2018 end-of-year basis and liability 
amounts are automatically updated to the 2019 beginning of the year amounts. Any 
loss or deduction carryover is updated to the beginning of the year and its character 
(ordinary loss, section 179 expense, charitable contributions, etc.) maintained.

Special 
Allocations

Use the SA screens to allocate liability, capital, and K-1 Part III (Income, Deductions, 
Credits, and Other Items) amounts to individual partners without having to enter the 
information into each K-1 separately. Amounts can be entered as dollar amounts or 
percentages. Calculations from the SA screens flow to the appropriate fields of each 
individual K-1.

For information on the SA screens, see “Special Allocations” on page 32.

Section 754 
Allocations

To allocate section 754 depreciation among specific partners:

1. Open screen 4562 for each asset for which you plan to allocate section 754 depre-
ciation.

2. Select 754 from the For drop list at the top of each screen 4562.
3. Open screen K and click the Deductions tab.
4. Click the SA link on line 13d, item W. (See “Special Allocations” on page 32 for 

details on using the SA screen.)

DOMESTIC PRODUCTION ACTIVITIES DEDUCTION

New for 2018: The Domestic Production Activities Deduction (DPAD) has been 
repealed for tax years beginning after 2017, with limited exceptions. For those excep-
tions, the 8903 screen, used to complete Form 8903, Domestic Production Activities 
Deduction, is still accessible from the Other Forms tab of the Data Entry Menu.

A taxpayer can take the DPAD on his or her federal 1040 Individual return only if the 
deduction has been passed through from a fiscal-year entity that began in 2017. If the 
DPAD has not been passed through from a fiscal-year entity, complete screen 8903 
only if it required for a state return. Be sure to read the screen help and the field helps 
on screen 8903 for more details.

K-1 COVER LETTERS

K-1 cover letters can be produced to accompany each Schedule K-1 in a return. You 
can set up the global option to produce K-1 cover letters for all returns containing K-1 
schedules, or you can choose the option on a per-return basis.

NOTE The Basis Worksheet (“Wks Adj Basis”) is printed only when the 
option is selected on the PRNT screen.

NOTE If a K1 screen is marked as Final K‐1, none of the related screens 
for that partner is updated for the next year.
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p

Producing 
Letters for 
All Returns

To have the K-1 cover letters produced automatically with all applicable returns, from 
the Home window menu bar of Drake Tax, go to Setup > Options > Optional Docu-
ments tab and mark the box labeled Include K-1 letter with returns. Click OK, then 
open a return.

The signature used on the letter flows from the PIN screen. You can override this 
name on the K-1 letters by going to the K1L screen (available from the Miscella-
neous tab of the Data Entry Menu) and, in the K1L - Schedule K-1 Cover Letter 
section at the bottom of the screen, entering a name and title of the person’s signature 
you wish to use. 

Editing the 
K-1 Letter

As with other letters provided by the program, you can edit the text to suit your office 
needs and style.

To edit the text of the K-1 letter:

1. From the Home window menu bar, select Setup > Communications Editor. 
The Client Communications Editor is displayed.

2. Select Open > Partnership > Partnership K1 Cover Letter to view the tem-
plate of the partnership K-1 letter.

3. Make any desired changes to the template.
4. Click Save.

Other K-1 
Letter 
Options

By default, the partnership’s name and address appear in the letterhead of the K-1 
cover letters, the information flowing from screen 1. (This assumes you first went to 
Setup > Communications Editor > Setup > Page Layout and selected the Use let-
terhead on letters box; otherwise, no header would be printed.)

(optional) To have your firm’s contact information and logo printed in the letterhead of 
the K-1 cover letters, go the K1L screen (available from the Miscellaneous tab of the 
Data Entry Menu), and from the Information on the K-1 coversheet... drop list at 
the bottom of the screen, select F - Print firm info/logo.

(optional) To prevent the partnership’s or the firm’s name and address from appearing 
in the header of the K-1 letter, select X - Don’t print entity info from the Informa-
tion on the K-1 coversheet... drop list at the bottom of the K1L screen.

NOTE
The program uses the name of the partner who signs the return 
(selected as the Signs return partner on the K1 screen) as the sig‐
natory of the K‐1 letter. Override this name with entries on either 
the PIN screen or K1L screen. (The K1L entries override entries 
from either the PIN screen or the K1 screen.)

TIP
Review the following sections of the 2018 Drake Tax User’s Manual 
before making changes to letter templates:

• “Introduction to Letters in Drake Tax” in Chapter 2, Installation & Setu

• The “Letter Keywords” section of Appendix B, Keywords

NOTE
For an amended return, the K‐1 letter automatically refers to the 
amended Schedule K‐1. To edit the letter for an amended K‐1, from 
the Client Communications Editor toolbar, select Open > Partner‐
ship > Partnership K1 Amended Letter and follow steps 3 and 4 
of the previous procedure.
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Once the required signing information has been selected, a K-1 cover letter will be 
generated for each partner receiving a Schedule K-1.

To change the firm’s letterhead information, from the Home window menu bar, select 
Setup > Communications Editor. Select Open > Partnership > Letterhead (all 
packages) and make whatever changes you wish. Click Save. 

SCHEDULE L (BALANCE SHEETS PER BOOKS)

Schedule L and Schedule M-2 reconciliation totals are displayed on screens L and M2 
to facilitate reconciliation of the balance sheet (item #1 in Figure 2-15).

Figure 2-15: Beginning- and End-of-Year totals displayed on L screen (#1);
force-printing end-of-year totals (#2); link to SCH2 screen (#3); 

force-printing Schedule L and M-1 (#4)

Note that the totals from the balance sheet’s subsidiary schedule (SCH2 screen link, 
item #3 in Figure 2-15) also appear in the BOY Totals and EOY Totals columns of 
the L screen.

If you make any changes to the data, recalculate the return (press CTRL+C) for those 
changes to be displayed on the screen.

NOTE Changes made to the letterhead affects the letterhead for letters in 
all packages.

TIP
For more on working with letterheads, see “Setting Up Letterheads, 
Logos, Footers, Margins, and Borders” in Chapter 2 of 2018 Drake 
Tax User’s Manual.

TIP To speed up calculation of returns that contain multiple states, 
open screen 1 and select 0 from the Resident state drop list.
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Schedule L is not required if:

• The partnership’s total receipts for the tax year were less than $250,000

• The partnership’s total assets at the end of the tax year were less than $1 million

• Schedules K-1 are filed with the return and furnished to the partners on or before 
the due date (including extensions) for the partnership return

• The partnership is not filing, and is not required to file, Schedule M-3

If the partnership meets all four of these conditions, go to screen B and select Yes for 
line 4. Because Schedules L, M-1, M-2, and section L of Schedule K-1 are not 
required, they will not be generated with the return. To force the program to generate 
these items, click the Force-print Schedule L and M-1 link on the L screen (see item 
#4 in Figure 2-15 on page 49) to open the PRNT screen. In the Items to Print section, 
select Force Schedules L, M-1, M-2, & K-1 Section L.

If any of the four conditions is not met, select No for line 4 on screen B. Schedules L, 
M-1, M-2, and Item L of Schedule K-1 are required and will be generated with the 
return.

Print End of 
Year Totals

If the Final return check box is marked on screen 1, you can select the Force-print 
final end of year check box (see item #2 in Figure 2-15 on page 49) to keep the pro-
gram from “zeroing out” the end-of-year totals.

Print
Section L

You can “force” the program to generate the K-1 section “L” information without gen-
erating any unnecessary Schedules L, M-2, and M-2.

From the PRNT screen (available from the Miscellaneous tab of the Data Entry 
Menu), select Force Schedule K-1 Section L only and any available data is gener-
ated in the “L” section, “Partner’s capital account analysis,” of Schedule K-1 
(Figure 2-16).

Figure 2-16: Section L information on Schedule K-1
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FLOW OF INFORMATION

Many entries made elsewhere on the return (for example, inventory information on 
screen A) flow to the generated Schedule L. Depreciable asset information, intangible 
assets, and amortization from the 4562 screen also flow to Schedule L. 

Direct entries on screen L include beginning- and end-of-year Cash, Trade notes and 
accounts received, bad debts, U.S. government securities, tax exempt securities, 
loans to partners, mortgage/real estate loans, depletable assets, and accumulated 
depletion. Other Schedule L data not entered on screen L would come from the part-
nerships’ income statement, balance sheet, and equity and capital accounts.

FORCE-PRINTING FINAL END-OF-YEAR TOTALS

Normally, if you mark Final on screen 1, indicating that this as a final-year return for 
a partnership, Drake Tax “zeros out” the EOY Totals column of Schedule L. Mark the 
Force-print final end of year check box on screen L (see item #2 in Figure 2-15 on 
page 49) to display those totals in the EOY Totals column.

THE SCH2 SCREEN

The SCH2 screen is used to provide detailed information required by the IRS for cer-
tain lines on Schedule L. This screen can be used in place of the actual L screen in 
Drake Tax. In other words, if you use this screen for all applicable lines on Schedule 
L, you do not need to make any entries on the L screen.

To create a statement for a line, select the line from the drop list (see Figure 2-17) and 
enter descriptions and their corresponding amounts. Once the information is entered, 
or if additional descriptions are required for the line, press PAGE DOWN to access a 
new screen.

Statements The total amounts entered on the SCH2 screen do not appear on the L screen in the 
program. They are, however, printed on the return where applicable, with references 
to the corresponding statements.

Note that an e-fileable “STATEMENT” is referenced in the return (Figure 2-17 on 
page 52).

NOTES

All line selections are carried to the next‐year program when 
the return is updated. Screen descriptions are updated, with 
the year‐end amounts from one year carried to the beginning‐
of‐year column of the next year.

To access the SCH2 screen from the L screen, click the SCH2 
screen links on lines 6, 8, 13, 17, or 20 (or click inside a field 
and press CTRL+2).
Tax Year 2018 51



Schedule M-2 (Analysis of Partners’ Capital Accounts) Drake Tax Manual Supplement: Partnerships
Figure 2-17: Data entered as “Other Current Assets” from the drop list on screen SCH2 will be 
attached as an e-fileable statement and referenced on the applicable line of the return.

SCH2 and 
Trial Balance

Typically, one or more SCH2 detail screens are needed for Schedule L items. If using 
Drake Tax’s trial balance import feature, be aware that SCH2 data cannot be entered 
directly into the trial balance worksheet, as it cannot be imported into the data entry. 
SCH2 detail screens must be created apart from the trial balance worksheet.

When the return is produced, Schedule L reflects the amounts imported from the trial 
balance worksheets (where direct entry was allowed). For more information, see 
“SCH2 Detail” on page 78.

AUTOBALANCE

Autobalance forces Schedule L to balance for both the beginning- and end-of-year 
amounts. The program adjusts the capital account on Schedule L by the difference 
between the total assets and the total liabilities and capital before the adjustment.

(Example: If Assets = $1,000 and Liabilities and Capital = $900, the program 
increases the partners’ capital accounts by $100.)

To deactivate this feature for a specific return, go to the PRNT screen and select Turn 
off autobalance.

SCHEDULE M-2 (ANALYSIS OF PARTNERS’ CAPITAL ACCOUNTS)

Schedule M-2 is used to show what caused changes during the year in the partners’ 
capital accounts. The amounts on Schedule M-2 should equal the total amounts 
reported in item L of all the partners’ Schedule K-1s.
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Amounts entered in item L (Analysis of Capital Account) on the partners’ K1 screen 
of Drake Tax flows to Form 1065, Schedule M-2, line 1, “Balance at beginning of 
year.”

SCHEDULES M-1, M-3 (RECONCILIATION OF INCOME)

Schedule M-1 is required if the balance sheet’s total assets at the end of the year are 
greater than $250,000. Page 1 of Schedule M-3 is required if the balance sheet’s total 
assets at the end of the year equal or exceed $10 million, and Schedule M-1 and pages 
1-3 of Schedule M-3 are required if the total assets equal or exceed $50 million.

SCHEDULE M-1
Schedule M-1 shows all items of income and expense that are not subject to tax, plus 
those accounting items that are not income tax items. When required, taxpayers must 
reconcile book income with the taxable income.

Use the M1 screen to enter book-to-tax difference for Schedule M-1. Book-to-tax dif-
ferences are classified as permanent or temporary, and as favorable or unfavorable, as 
described in Table 2-2:

 “Other” 
Adjustments

Open the Schedule M1 Other Adjustments screen to make adjustments to Section L, 
“Partner's capital account analysis,” of the partners’ Schedule K-1. To open the 
Schedule M1 Other Adjustments screen, click a blue Other link (circled in 
Figure 2-18 on page 54) on lines 2, 4, 6 or 7 of screen M1.

Table 2-2: Examples of Book-to-Tax Difference for Schedule M-1

Difference Description Examples

Permanent Book or tax items that will never be 
reported for book or tax purposes

- Meals & entertainment limitations

- Penalties

- Tax-exempt interest

Temporary Items that will be reported for both 
tax and book purposes, but not 
during the same tax year

- Depreciation

- Gains or losses on the sale of 
depreciated assets

Favorable Items that reduce taxable income - Instances in which tax depreciation 
amount is greater than book depre-
ciation amount

Unfavorable Items that increase taxable income - Disallowed meals & entertainment
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Figure 2-18: Other screen links from screen M1

On the Other screen, enter a Description and an Amount and close the screen. When 
you calculate the return, the amounts entered on the Other screens have adjusted Sec-
tion L of the Schedules K-1.

Depreciation
and
Amortization
Adjustments

The program may make an adjustment for book-to-tax depreciation differences. The 
calculation is done with the following steps. (This procedure refers to “depreciation” 
throughout, but it applies for either depreciation or amortization.)

1. The amount reported on Schedule L “Beginning of Year” accumulated deprecia-
tion (line 9b, column a) (line 10b is “accumulated depletion”), is subtracted from 
the “End of Year” accumulated depreciation (line 9b, column c). This is the “book” 
depreciation amount.

2. This “book” depreciation amount is compared to the “tax” depreciation amount. 
(The “tax” depreciation amount is the depreciation amount reported on the 
return, including any section 179 amounts).

3. The differences between the “book” and “tax” depreciation amounts are carried to 
the appropriate form and line.
• If the “book” depreciation amount is greater than the “tax” depreciation 

amount, the difference is carried to either:
– Schedule M-1, line 4a
– Schedule M-3, Part III, line 25, as a negative amount
– Form 8916-A, line 2(L), as a negative amount for assets selected on the 

4562 detail screen for COGS
• If the “tax” depreciation amount is greater than the “book” depreciation 

amount, the difference is carried to either:
– Schedule M-1, line 7a
– Schedule M-3, Part III, line 25, as a positive amount

NOTES

If you enter an amount in the line 2, 4, 6, or 7 override fields on 
screen M1, and enter that amount again on the Other screen, the 
amounts will be added and the total will flow to Schedule M‐1. 
(Only the amount entered on the Other screen affects Section L 
of Schedule K‐1, however.)

To allocate these adjusted amount to the partners, click the SA 
link on the right side of the Amount field on the Other screen. 
For more on using the Special Allocation (SA) screens, see “Spe‐
cial Allocations” on page 32.
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– Form 8916-A, line 2(L), as a positive amount for assets selected on the 
4562 detail screen for COGS

SCHEDULE M-3
The Schedule M-3 section of the Data Entry Menu includes direct access to the var-
ious M3 screens (Figure 2-19).

Figure 2-19: Data Entry Menu for M and M-3 schedules

If a domestic partnership reports on Form 1065, Schedule L, that its total assets at the 
end of its tax year equal or exceed $10 million (or that its gross receipts equal or 
exceed $250,000), it must complete and file Schedule M-3 instead of Schedule M-1.

Parts II and III of Schedule M-3 reconcile financial statement net income (loss) for the 
tax return (per Schedule M-3, Part I, line 11) to net income (loss) on Form 1065, page 
5, “Analysis of Net Income (Loss),” line 1.

If the partnership is required to file (or voluntarily files) Schedule M-3, the partnership 
must file Form 1065 and all attachments and schedules, including Schedule M-3. 
Additional information could be required on the 8916 and SCH3 screens.

FORCE-PRINTING SCHEDULE M-3
Page 1 of Schedule M-3 is required if the balance sheet’s total assets at the end of the 
year equal or exceed $10 million, and pages 1-3 of Schedule M-3 are required if the 
total assets equal or exceed $50 million. If the corporation’s assets do not equal or 
exceed $10 million but you want to voluntarily file Schedule M-3, or if the corpora-
tion’s assets do not equal or exceed $50 million and you wish to file the complete 

NOTES
The program calculates total assets based on IRS requirements. 
For more information, see the Adjusted Total Assets Worksheet 
produced with the return.

Some calculated amounts flow automatically to M‐3; some data 
must be manually entered on the M3 screen. Review all 
amounts on the M‐3.

IMPORTANT The program does not autobalance Schedule M‐3. 
Additional data entry is required on screen M32, line 
25 to reconcile with the analysis of net income.
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M-3, go to screen M3 and make a selection from the Force print schedule M-3 drop 
list. Choose to print just page 1 of Schedule M-3 or the complete M-3.

See “Schedules M-1, M-3 (Reconciliation of Income)” on page 53 for more details on 
these schedules.

SCH3
Screen

The SCH3 screen is used to provide detailed information required by the IRS for cer-
tain lines on Schedule M-3 (or Form 8916-A). This screen can be used in place of the 
actual M3 screen in Drake Tax. In other words, if you use this screen for all applicable 
lines on Schedule M-3 or Form 8916-A, you do not need to make any entries on the 
M3 and 8916 screens. The total amounts entered on the SCH3 screen do not show up 
on the actual M3 and 8916 screens in the program; they are, however, printed on the 
return as applicable, with references to the corresponding statements.

To create a statement for a line, select the desired line from the Select line number 
from drop list on screen SCH3, then enter descriptions and their corresponding 
amounts. Once the information is entered, or if additional descriptions are required for 
the line, press PAGE DOWN to access a new screen (make the same selection from the 
Select line number... drop list.)

As with the SCH2 screen, the type of statement produced by the program depends on 
the line selected on the SCH3 screen and the IRS requirements. See “The SCH2 
Screen” on page 51 for more information on how to use the SCH3 screen.

Allocating 
M-3 Items

The SA links on screens M32 and M33 (Parts II and III) for Schedule M-3 allow you 
to allocate to the partners any Temporary Differences and Permanent Differences for 
income items (screen M32) and expense items (screen M33).

As with most of the SA links in the program, to use these SA links, you must first 
enter data on the screen, then save (close) the screen. Reopen the screen, and click the 
SA link to open the Special Allocations dialog box for the line you selected.

See “Special Allocations” on page 32 for details on using the SA links.

RENTAL ACTIVITIES

Screen code: 8825 Income and expenses for rental real estate properties appear on Form 8825, Rental 
Real Estate Income and Expenses of a Partnership or an S Corporation. To make 
entries in Drake Tax, use the 8825 screen, available from the Other Forms tab of the 
Data Entry Menu. (Grid data entry is available. See “Grid Data Entry” on page 42 
for details on using this feature.)

If there are multiple 8825 properties, press PAGE DOWN for a new 8825 screen. Use 
one screen per rental property. If a return has more than one 8825 screen, the program 

NOTE All line selections flow to the next‐year program when the return 
is updated. 
56 Tax Year 2018



Drake Tax Manual Supplement: Partnerships                                                                                Rental Activities
reports each property’s information on a separate column of Form 8825. Data from all 
8825 screens are transmitted to the IRS when the return is e-filed.

LINE 14, DEPRECIATION

If the program is calculating depreciation (entered on the 4562 screen) for the property 
listed on the 8825, do not enter the depreciation on the 8825 screen. Depreciation 
should be entered only if it is figured outside of the Drake Tax program, and then the 
net results should be entered on screen 8825. Line 14 of the 8825 screen is an adjust-
ment field: any amount entered on line 14 is added to the depreciation calculated from 
the 4562 screens.

Carrying 
Information 
to Form 8825

To indicate that the information should flow to Form 8825, select 8825 from the For 
drop list on screen 4562 (Figure 2-20). If there are multiple 8825 screens, use the 
Multi-form code box. For information on using the Multi-form code box, see the 
2018 Drake Tax User’s Manual.

Figure 2-20: In this example, the program sends the 4562 information
to the third 8825 screen created.

Any depreciation information entered on the 4562 screen flows to the correct Form 
8825, based on the form and multi-form code selections at the top of the 4562 detail 
screens.

Line 15, 
Other 
Expenses 

For rental properties with an “other” expense (line 15 of Form 8825), enter the amount 
of guaranteed payments, health insurance payments, and meals and entertainment in 
the appropriate fields of the 8825 screen (see figure on next page). For rental proper-

NOTE Special steps are required if using the trial balance worksheet for 
multiple rentals. See “Rental Expenses” on page 79 for more 
information.

NOTE
For assets placed in service during the year, Form 4562 is required.

Drake Tax produces one Form 4562 for each property on Schedule 
E and Form 8825 instead of one 4562 per Schedule E or 8825.

IMPORTANT

When selecting a multi‐form code, note that the code 
should refer to an 8825 screen—not the 8825 form. 
For example, data from the third 8825 screen is gen‐
erated on the first Form 8825. To associate an asset 
with that information, you would type a “3” for the 
screen (not a “1” for the form) in the Multi‐form 
code box. For more information on Form 8825, see 
“Viewing Rental Activity Information,” following.
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ties with expenses not listed, enter those amounts in the Additional other expenses 
field. (An entry in this field opens a Detail Worksheet. Enter a description in the 
Description field and an amount in the Amount field.) The shaded field indicates a 
worksheet was entered.

Totals from 
the work-
sheet flow 
to Form 
8825, and a 
statement 
from each 
property is printed with the return and transmitted to the IRS when the return in trans-
mitted.

Enter rental income the partnership receives on a Schedule K-1 on the K1P screen. 
This amount flows to Form 8825, lines 20a and 20b. No entry is required on the 8825.

VIEWING RENTAL ACTIVITY INFORMATION

Rental activity data is reported on the 8825 forms and accompanying statements.

• 8825 Forms — Form 8825 can contain information for up to eight rental activities. 
If more than four rental activities are entered, a second page of Form 8825 is gener-
ated. If more than eight rental activities are entered, a second Form 8825 is created 
(figure at right).

• 8825 Statements — Statements are 
titled “Statement 8x,” (or “STM 8X, 
depending on your Setup options) 
where “X” equals “A” to “H” for 
the first Form 8825. (For example, 
the statements for the first and sec-
ond 8825 screens would be labeled 
“Statement 8A” and “Statement 
8B,” respectively.) (See Figure 2-
21 on page 59.)

NOTE
Entries in the “Guaranteed payments” field and “Health Insur‐
ance payments” field on line 15 do not flow to line 10 of Form 
1065 but do flow to Form 8825 and adjust the amounts on lines 2 
and 4 of Schedule K.
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Figure 2-21: 8825 statements and attachments

SELF-EMPLOYMENT INCOME

If Mark this box to include in self-employment income is selected at the top of the 
8825 screen, the amounts from the 8825 screen are included in the calculation for line 
14a of Schedule K and flow to each K-1. Self-employment calculations are shown on 
the “Wks Sch K” worksheet generated with the return.

ROYALTIES WORKSHEET

When income and expenses from royalties are listed on screen 8825 (and Royalties is 
selected from the Type of property drop list), Drake Tax generates the Royalty Work-
sheet (“Wks PROY” in View/Print mode), along with a K-1 Royalty Worksheet 
(“Wks K-1 PROY”) for each partner. 

When a 1065 return is viewed, instead of the royalties income and expenses flowing to 
box 2, “Net rental real estate income,” of Schedule K-1, gross royalties flow to Sched-
ule K, line 7, “Royalties,” and expenses to Schedule K, line 13d, “Other deductions.” 
These amounts are also on the Royalty Worksheet.

Form 8825 isn’t generated unless it is otherwise needed.

CREDITS AND ADJUSTMENTS

Certain credits require an adjustment to either income or expenses. Drake Tax carries 
the required adjustments to the appropriate line of the return and to the M-1.

NOTE No adjustment is carried to Schedule M‐3 automatically.
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Manually reducing the expenses/deductions or increasing the income for these credits 
causes the return to be out of balance.

Adjustments are made to other income for the credit amounts for the following cred-
its: 

• Form 8912, Credit to Holders of Tax Credit Bonds (interest income)

Adjustments are made to the appropriate deduction/expenses for the credit amounts 
for the following credits:

• Form 5884, Work Opportunity Credit

• Form 6765, Credit for Increasing Research Activities

• Form 8820, Orphan Drug Credit

• Form 8846, Credit for Employer Social Security and Medicare Taxes Paid on Cer-
tain Employee Tips

• Form 8881, Credit for Small Employer Pension Plan Startup Costs

• Form 8912, Credit to Holders of Tax Credit Bonds

• Form 8941, Credit for Small Employer Health Insurance Premiums

ELECTIONS

The ability to make certain tax elections is included in the Partnership package. Elec-
tions are made and described on the ELEC screen (Figure 2-22 on page 61).

MAKING AN ELECTION IN DRAKE TAX

Screen code: 
ELEC

To indicate that the partnership is making an election:

1. Open the ELEC screen (accessible from the Miscellaneous tab of the Data 
Entry Menu).

2. Make a selection from the Election drop list.
3. Complete all other fields as applicable. Press F1 in any field to learn if that field is 

required for your selection and the type of information that may be needed. For 
example, the help text for the Date or year-ending field (Figure 2-22 on 
page 61) shows that the field is required only for election options 08, 11, 13, 15, 
and 21, and it explains what, specifically, should be entered for each of these elec-
tions.

NEW FOR 

2018

Certain “extender” credits are no longer available. Because, in certain situa-
tions, credit amounts can be carried forward from 2017 to a 2018 return, the 
screens are still included in the program.

Amounts from the following screens no longer flow to line 5 of Form 1120S:

• 6478 (Form 6478, Biofuel Fuels Credit)

• 8864 (Form 8864, Biodiesel and Renewable Diesel Fuels Credit)
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Figure 2-22: Help text for Date or year-ending field on ELEC screen

To open a new ELEC screen for an additional election, press PAGE DOWN.

ELECTION STATEMENTS

Once an election is made and the return is calculated, the election information is pro-
duced on a statement referenced “Statement EL XX,” where “XX” is the number of 
the election. For example, election 01 (General Election Statement) is generated as 
“Statement EL 01.”

The election statement includes the election title, election wording, and any additional 
information required for the election, such a date, amount, or location.

Entries for certain fields are sometimes included in the actual election statement; other 
times, they are included as separate lines. Signature lines are printed as needed on 
some statements.

SAFE HARBOR ELECTIONS 
A Building qualifies as Section 1.263... check box on screen 4562 applies a small 
taxpayer Safe Harbor election to a building listed in the Description field. An election 
statement will be produced and the building description as entered in the Description 
field will be included in the election statement (see Figure 2-23 on page 62).

NOTE
If the election option you selected is not listed in the help text for 
a field, then that field should be left blank. For example, if you 
chose election 01 (General Election Statement), you would not 
need to enter anything into the Date or year‐ending field (help 
text in Figure 2‐22).
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This Sec. 1.263(a) - 3(n) Election can also be made from the ELEC screen, as can a 
Sec. 1.263(a) - 1(f) de minimis safe harbor election.

See IRS Reg. section 1.263(a)-3(h), IRB 2013-43, Rev. Proc. 2014-16, and Rev. Proc. 
2015-14 for guidance.

Election statements are generated with the return (Figure 2-23 on page 62).

Figure 2-23: Election statements, including Safe Harbor election

See IRS Reg. section 1.263(a)-3(h), IRB 2013-43, Rev. Proc. 2014-16, and Rev. Proc. 
2015-14 for guidance.

MAKING CHANGES ON THE FLY

Screen code: 
PRNT

Use the PRNT screen (accessed from with the General or the Miscellaneous tabs of 
the Data Entry Menu) to override program defaults.

SUPPRESSING/FORCING DOCUMENTS

To suppress or force the printing of certain documents, go to the PRNT screen and 
select the desired options. Many “on the fly” changes override global setting from 
Setup > Options. 

1065 Items The following Form 1065 items can be “forced” (forced to be generated or printed) or 
suppressed from the PRNT screen:

• Force Schedules L, M-1, M-2 & K-1 Section L — Schedules L, M-1, M-2, and 
K-1 Section “L” are not printed unless required. To have these schedules printed 
with the return, select this box.

• Force Schedule K-1 Section L only — “Force” the program to generate the K-1 
section “L” information without generating any unnecessary Schedules L, M-2, 

NOTE This Safe Harbor election covers buildings only.
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and M-2. Any available data is generated in section “L, Partner’s capital account 
analysis,” of Schedule K-1.

• Print Form 4562 — Form 4562, Depreciation and Amortization, is not generated 
unless applicable. Select this box to force the Form 4562 to be printed. (To force 
Form 4562 for all returns, go to Setup > Options > Form & Schedule Options, 
and clear the check box labeled Print Form 4562 only when required.)

• Print next-year depreciation listing— Select this box to print the next year’s 
depreciation schedule if the option is not already selected in Setup > Options > 
Form & Schedule Options.

• Print inactive return — By default, the program does not generate a return for a 
partnership that is inactive. Select this option to override the default for an inactive 
return.

• PIN — To have the preparer’s signature appear on the printed copy of return, enter 
the preparer’s PIN here This should be used for the client's and preparer's printe 
copies when the return has been e-filed.

• Items to Suppress — Select the boxes corresponding to any worksheets, forms, or 
functions you do not want printed with the return:
– “Wks Tax/Lic” or the “Wks Sal/Wage” reference on page 1
– Estimated Tax Payment Summary
– Printing of “Wks M-2,” Partners’ Capital Reconciliation Worksheet
– Proformas for next tax season

• Special Allocation Statement — Select to keep the statement listing all special 
allocations from being generated.

K-1 Items Described below are Schedule K-1 items that can be forced or suppressed from the 
PRNT screen:

• Select to print:
– The partner’s adjusted basis worksheet
– Page 2 of Schedule K-1 (codes)

• Select to Suppress:
– Schedule K-1, K-1 letter, K-1_ATT, or WK_PBAS
– Schedule K/K-1 Comparison Worksheet or the Capital Account Reconcilia-

tion
– K1_179 for each partner
– Marking of “Amended K-1” box on printed Schedule K-1

• Item L on Schedule K-1 (Partner’s capital account analysis) — Select the box 
(item #1 in Figure 2-24 on page 64) to indicate the calculation method used for the 
partners’ capital account. (If Other, indicate the method in the text box; this item is 
required.)
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Figure 2-24: Items L and M of PRNT screen

• Item M on Schedule K-1 — Select a box (item #2 in Figure 2-24) to answer item 
M of Schedule K-1 for all partners. To answer it for each individual partner, go to 
the partners’ K1 screens. See “Item M Question” on page 46 for more information.

See field helps (F1) for more information on the options available.

OVERRIDING OTHER SETUP OPTIONS

Filing instructions (federal and state) and envelope coversheets (partnership, IRS, 
state, city, and K-1s to partners) can be either forced or suppressed from the PRNT 
screen to override the global selections in Setup Options.

In addition, you can select Turn off autobalance to disable the autobalance feature 
(see “Autobalance” on page 52) and select Prepare a Form 7004 extension if send-
ing an extension application. (See “Filing an Extension” on page 22.)

The following program default settings can also be overridden from the PRNT screen:

• Date to print on return

• Due date to print on letter and filing instructions (see note below)

• Amount on Form 1065, page 1, item F (“Total assets”)

• IRS Service Center

Much of the information contained in the worksheets is also available from the field-
level helps within the program. To access a field-level help, click inside a field and 
press F1, or right-click in a field and select Help > Help for this Field.

OPTIONAL (BUT RECOMMENDED) SECURITY INFORMATION

The information on the Filing Security Information screen (SEC) of the Partnership 
package is transmitted when the tax return is e-filed. Completing this screen for fed-
eral returns is strictly optional for 2018; however, certain states will begin requiring 
this information in the near future.

Screen (SEC) is accessible through a link on screen 1 or from the Data Entry Menu.

NOTE
The default due date for filing is printed on all letters and filing 
instructions generated with a return. You can override the 
default by entering an alternate due date in the Due date to 
print on letter and filing inst field.
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ELECTRONIC FILING

Some partnerships with more than 100 partners are required to e-file Form 1065, 
Schedules K-1, and other related forms and schedules. For other partnerships, e-file is 
optional.

Steps for e-filing Form 1065 are the same as for e-filing Form 1040, with the excep-
tion of a bankruptcy return, which must be paper-filed. For detailed instructions on
e-filing returns in Drake Tax, see 2018 Drake Tax User’s Manual.

ADDITIONAL RETURN TYPES

The following special types of business returns can be e-filed using Drake Tax:

• Form 5471, Information Return of U.S. Persons with Respect to Certain Foreign 
Corporations

• FinCEN Form 114, Report of Foreign Bank and Financial Accounts

• Returns for entities using a 52-53–week year

• Short-year returns

• Inactive returns

For information on how to indicate a short-year return in Drake Tax, see “Short-Year 
Returns” on page 13.

FORM 5471
Screens used to complete Form 5471, Information Return of U.S. Persons with 
Respect to Certain Foreign Corporations, are also found on the Foreign tab of the 
Data Entry Menu. This form is used by certain U.S. citizens and residents who are 
officers, directors, or shareholders, or partners in certain foreign corporations.

Taxpayers who must file this form are described in the IRS instructions. Form 5471 
will not be e-filed with the 1065 return. File by the due date (including extensions) for 
that return.

For details on using this form, see the IRS instructions for Form 5471.

E-FILE FINCEN FORM 114
Use screens on the Foreign tab of the Data Entry Menu for entering data on foreign 
financial accounts, for filing FinCEN Form 114, Report of Foreign Bank and Finan-
cial Accounts, and Form 8804, Annual Return for Partnership Withholding Tax allo-
cable to foreign partners.

Screen 8813, used for completing Form 8813, Partnership Withholding Tax Payment 
Voucher, allows you to enter amounts paid by the partnership in the prior year on for-
eign tax withheld and to produce vouchers for making 2019 quarterly payments. The 
filing and mailing instructions are listed on screen 8813.

When you calculate a return in Drake Tax, any required information missing from 
screens 114 and FRGN generates EF Messages unique to the FinCEN Form 114 – 
listed in “FBAR Messages Pg” in View/Print mode. Before the FinCEN Form 114 can 
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be eligible for e-file, all FinCEN 114 EF Messages on the “FBAR Messages Pg” must 
be cleared (and FinCEN has a green check mark on the Calculation Results window 
if you have the Pause option selected at Setup > Options > Calculation & View/
Print).

In data entry, open screen EF and mark the FinCEN 114 only check box. Click View 
(or press CTRL+V). “FinCEN114” will be indicated on the EF Status page in View/
Print mode and “Form 114” is displayed in the forms “tree” and is listed on the bill.

Close the return, and from the Home window toolbar, go to EF > Select Returns for 
EF. “FinCEN 114” will be displayed in the EF Documents column of the EF Return 
Selector. EF. “FinCEN 114” will be displayed in the EF Documents column of the EF 
Return Selector.

Proceed as you would to e-file any other return in Drake Tax.

• No other returns—state or federal—can be transmitted with the FinCEN Form 114 
through Drake Tax.

• Form 114, Report of Foreign Bank and Financial Accounts (FBAR), can be e-filed 
through Drake Tax in the same way all returns are e-filed through Drake Tax (see 
2018 Drake Tax User’s Manual. This report can also be completed on, and submit-
ted through, the BSA E-Filing System for the Financial Crimes Enforcement Net-
work website at http://bsaefiling.fincen.treas.gov/main.html

The link to the BSA website is still available on screen 114 for those who prefer that 
method of filing or who are seeking more information on the BSA E-Filing System for 
the Financial Crimes Enforcement Network.

ELECTING A 52-53–WEEK YEAR (INITIAL RETURN)
To elect a 52-53–week year, a new entity (one that has never filed a return) must enter 
data on both screen 1 and the Year screen.

To elect a 52-53–week year for any entity:

1. In the If not calendar year section of screen 1, enter the Fiscal year begin-
ning and Fiscal year ending dates. Use MMDDYYYY format, as shown in the 
example in the figure below.

2. Mark the 52-53-week tax year box.

In this example, the fiscal 
year begins 09/29/2018 
and ends 09/27/2019
(the last Friday in Septem-
ber), giving the entity a 

53-week year for 2018.

TIP For more on completing FinCEN Form 114, see “Foreign Financial 
Accounts” in Chapter 5 of the 2018 Drake Tax User’s Manual.

NOTE An entity that has filed returns in the past must complete only 
steps 1 and 2 of this process. An entity that has never filed a return 
before must continue with steps 3 through 6.
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3. Click the Year link to open the Election Options screen.
4. For line 1, 

select the 
month in 
which the 52-
53–week year 
ends for the 
current fiscal 
year. (01 = 
January, 02 = February, etc.)

5. For line 2, select the day of the week the tax year always ends.
6. For line 3, enter the actual date that the tax year ends (the same date entered in 

the Fiscal year ending field on screen 1).

In subsequent years, only the 52-53–week tax year check box on screen 1 must be 
marked; the program automatically updates the dates.

INACTIVE RETURNS

Entities that are inactive but are still required to file returns may e-file inactive returns 
in Drake Tax. To indicate that a return is inactive:

Screen Code: 
PRNT

1. Go to the PRNT screen, accessible from the General tab or the Miscellaneous 
tab of the Data Entry Menu.

2. Under Items to Print, mark the Print inactive return box.

When the return is calculated, the program displays the words “Inactive Return” on 
the main form of the return (specifically, to the right of lines 1a and 1b). Zeros (“0”) 
are displayed where required by the IRS in order for amounts to be properly included 
in the e-file data.

COMMON REJECT CODES

If one or more of the following IRS reject codes are generated when you e-file a 1065 
return, you must contact the IRS for further information.The e-file help desk number 
is (866) 255-0654.

• Reject Code R0000-922-01 — Filer’s EIN and name control in the return header 
must match data in the E-File Database, unless “Name Control” or “Name of 
address change” check box is checked, if applicable.

NOTE
Once a 52‐53–week year is selected, the entity must use that 
accounting period every year. To change accounting periods, the 
entity must submit to the IRS Form 3115, Application for Change 
in Accounting Method. Screens for completing Form 3115 are 
available from the Other Forms tab of the Data Entry Menu.

NOTE All EF Messages must be cleared in order to e‐file an inactive 
return.
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• Reject Code R0000-900-01 — The return type indicated in the return header must 
match the return type established with the IRS for the EIN.

BINARY ATTACHMENTS

Binary, or PDF, files can be attached to certain tax forms. These attachments are gen-
erally signature or third-party documents such as a copy of a signed lease or a signed 
appraisal statement. In some instances, the IRS requires that a document be attached 
to an e-filed return; in other instances, a document can be attached voluntarily to sup-
port or explain an entry in the return. In either case, a document must be printed, 
scanned into the computer, and attached to the return in order to be e-filed with the 
return.

THE PDF ATTACHMENT PROCESS

Three main steps are involved in the PDF attachment process in Drake Tax:

1. Creating a PDF document to be attached
2. Informing the program that a PDF document will be sent with the return
3. Attaching the PDF document for e-file

These steps are described in the following sections.

Creating a 
PDF File

To create a PDF file:

1. Scan the document to be attached to the return.

2. Save the document to your client’s Drake Documents file, your computer’s desk-
top, or anywhere you can readily find it.

Adding PDF 
Documents 
in Drake

To indicate in the program that a PDF document will be sent with the return:

1. Open the return in Drake Tax.
2. From the Data Entry Menu, click PDF Attachments, accessible from the 

Electronic Filing section of the General tab (or type PDF in the selector field 
and press ENTER). (Figure 2-25 on page 69)

NOTE
If a reject associated with the return’s “Name Control” occurs, 
some of your questions can be answered on the IRS’s website. For 
details, go to irs.gov/Tax‐Professionals/e‐File‐Providers‐&‐Part‐
ners/Using‐the‐Correct‐Name‐Control‐in‐e‐filing‐Partnership‐Tax‐
Returns

TIP It’s a good idea to use the scanning feature in Drake Documents for 
this step.

NOTE Many types of documents (for instance, documents created in Mic‐
rosoft Word) can be printed or “saved” as PDF documents if you 
have a PDF printer (such as Adobe Reader) installed.
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Figure 2-25: Select PDF Attachments, or type PDF into the selector field and press ENTER

3. Fill out the columns on the PDF Attachments screen. See Table 2-3 for exam-
ples.

4. Exit the PDF Attachments window.

Because you’ve indicated that a PDF document is attached, the program generates an 
EF Message regarding the attachment when the return is calculated.

Attaching 
Documents 
to the Return 

To attach a PDF file to a return:

1. From the return, click View. If anything was entered in the PDF Attachments 
window, there will be three PDF–related items in the View/Print window:
• An “MESSAGES” alert (item #1 in Figure 2-26 on page 70)
• An “EF Attachments” document (blue squares in Figure 2-26 on page 70) 
• An Attach PDF button on the toolbar (item #2 in Figure 2-26 on page 70)

Table 2-3: PDF Attachment Window Columns

Name of Column Description Examples

Reference Source

(This field is for your 
records only; it is not 
transmitted with the 
PDF.)

Name or number of regulation, 
publication, or form instruction that 
makes attachments necessary

- IRS Pub xxx-1.4

- Form Instructions for 1065

Description Description of form or document to 
be attached

- Title of house on Oak Street

- Appraisal of Lot 1234

File name Distinctive, easily recognizable file 
name, followed by “.pdf”

- TitleHouseOakSt.pdf

- AppraisalLot1234.pdf
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Figure 2-26: The MESSAGES file (1) and the Attach PDF button (2)

2. Click the EF PDF file from the forms tree to see a listing all documents entered on 
the PDF screen.

3. Click the MESSAGES file to view EF Messages, including information on how to 
attach the required documents to the return.

4. Click the Attach PDF button. The EF PDF Attachments window displays the 
information entered on the PDF Attachments window in data entry. A red X 
means the document has not yet been attached; a green check mark indicates an 
attached document (Figure 2-27).

Figure 2-27: The EF PDF Attachments window

5. Click the row of a document to attach.
6. Click Browse.
7. Find to the proper folder, select the PDF file to attach, and click Open (or double-

click the file name).

Repeat for all documents with a red X. When all documents have been attached to a 
completed return (and show a green check mark), recalculate the return. If all EF Mes-
sages have been resolved, the return is ready to be e-filed.
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IMPORTING TRIAL BALANCE INFORMATION

Drake Tax’s trial balance import feature allows data to be imported into a 1065 return 
from a trial balance worksheet. The trial balance template and importing function has 
the following benefits:

• Eliminates the need to duplicate entries

• Reduces data entry errors by automatically importing data to the correct fields

• Allows preparers to merge basic accounting functions with tax preparation

PREPARING TO USE TRIAL BALANCE IMPORT

The trial balance import function can be used only on returns that were created in 
Drake Tax 2008 or later. Like several other functions of the tax software, this feature 
requires Microsoft Excel (version 2000 or later).

First, if you haven’t already, create a client file (open a new return) in Drake Tax 2018 
or update an existing client file from the prior year. Then create a trial balance work-
sheet. (See “Opening a Template” on page 73.)

Take the following steps to ensure the trial balance import works properly:

• Activate Macros — The trial balance import function uses macros in Microsoft 
Excel. Check your Excel settings to ensure that macros are activated and that 
macro settings are set to “Disable all macros with notification.” To do so, go to File 
> Options in Excel and select the Trust Center tab. Click Macro Settings and 
select Disable all macros with notification, then click OK.

• Disable Autobalance in Drake Tax — (optional) When autobalance is disabled, 
the program is prevented from automatically adjusting the year-end retained earn-
ings or capital amounts, thus allowing you to see any discrepancies in the balance 
sheet. To disable autobalance in Drake Tax, go to the PRNT screen and select 
Turn off autobalance (Figure 2-28 on page 72).

NOTE A flow chart of the trial balance importing process is available as 
Appendix A, Trial Balance Import (pages A‐1 to A‐2 of this manual).

NOTES

In Excel 2007, click the Office button in the upper left and then 
click the Excel Options button at the bottom of the window. (In 
Excel 2013, click the File tab then select Options from the menu on 
the left.) Next, select Trust Center from the list at left, then click 
the Trust Center Settings button. Select Macro Settings from the 
list on the left, then choose Disable all macros with notification. 
Click OK and then OK.
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Figure 2-28: Disable autobalance in Other Return Options section of PRNT screen

• Force Schedule L — By default, the program does not display the balance sheet 
amounts on the return if the partnership does not meet the filing requirement. If this 
is the case, you will have to override the default setting in order to have the 
amounts displayed on Schedule L. To force the Schedule L amounts to be printed, 
go to the PRNT screen and select the Force Schedules L, M-1, M-2, & K-1 Sec-
tion L box (Figure 2-29).

Figure 2-29: Force Schedule L box for 1065 package

• Check for Detail Worksheets — The trial balance import allows only those detail 
worksheets required by the IRS. Check updated returns for detail worksheets 
(CTRL+W) that are not required. For example, the IRS does not require a detail 
worksheet for the Gross receipts field on the INC screen; if a return has a detail 
worksheet for that field, the trial balance will not be imported correctly into the 
return. Detail worksheets are indicated by red shading, as shown in Figure 2-30.

Figure 2-30: Example of an “unnecessary” detail worksheet

Remove unnecessary detail worksheets prior to import. See “Detail Worksheets” 
on page 74 for more information on using detail worksheets in the trial balance.
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PREPARING FINANCIAL DATA FOR IMPORT

To prepare the financial data for importing into the return, the data must be entered 
into Drake Tax’s specially designed trial balance template. Once this information is 
entered and saved, it can be imported into the return.

Opening a 
Template

The first step in preparing financial data for importing is to open a trial balance tem-
plate for the return and enter the financial data.

To open a trial balance template for a return:

1. Open the return to the Data Entry Menu.
2. Click Import > Trial Balance Import from the Data Entry Menu toolbar. 

The preliminary Trial Balance Import dialog box is opened.
3. Click Create New or Open Existing. If opening an existing file, click Open 

after selecting the correct file.
4. If a Security Warning box appears, click Enable Macros.

The trial balance template is displayed in Microsoft Excel.

File Location Whenever a new template is opened, the tax program assigns it a default file location 
and name. Trial balance templates are saved in the “TB” folder of your Drake Tax ’18 
program. 

To change the name of a file in Excel, select File > Save As and assign the new name.

Template 
Structure

The trial balance template consists of three title rows and six columns. The Partner-
ship Name and Year End Date title rows can be edited; double-click a row to change 
the title. Columns are described in Table 2-4.

NOTE
In Excel 2007 and 2010, you may see a Security Warning message 
with an Options button. Click Options to open the Security 
Options dialog box, then select Enable this content. Click OK. (In 
Excel 2013, click Enable Content.)

NOTE If saving a trial balance to a different location, make a note of 
where you store it. The program automatically looks in the 
default directory.

Table 2-4: Trial Balance Template Columns

Column Description

Account Title Title of account

Debit/Credit Debit and credit amounts

Import to Screen and line in Drake Tax to which the debit or 
credit amount is imported

Reported on Location of the amount on the printed return

Other Information Additional details for preparers; see “Details for Pre-
parers” on page 77.
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Displayed at the bottom of the trial balance worksheet are the calculated amount for 
Schedule M-1, line 1; the credit and debit totals; and a cell showing whether or not the 
balance sheet is out of balance and, if applicable, the out-of-balance amount (Figure 2-
31).

Figure 2-31: Schedule M-1 amount (item #1); totals (#2); and indication of balance (#3)

Following are instructions and guidelines for using the trial balance template to 
assemble financial data for importing into data entry.

Entering Financial Data

When a new trial balance file is opened for a return, all debit and credit amounts are 
zero ($0). All data must be entered manually into the template.

Direct Entry Most cells in the trial balance worksheet are view-only. In a new template, editable 
debit and credit cells are indicated by a dollar amount ($0).

Detail 
Worksheets

Some cells require more detail than can be entered on a single line. These cells are 
indicated by buttons (Figure 2-32). If these cells do not work, you may need to acti-
vate them; see the Note in “Opening a Template” on page 73.

Figure 2-32: Example of cells that require worksheets

NOTE
Some data cannot be imported from the trial balance worksheet 
into the tax program and must be entered directly into the data 
entry fields within the Drake Tax program. For more on these 
categories of data, see “Special Conditions” on page 77.
74 Tax Year 2018



Drake Tax Manual Supplement: Partnerships                                                                                Importing Trial Balance 
Click a worksheet button to open a worksheet in a new tab. Figure 2-33 shows an 
example of the “Other Income” worksheet.

Figure 2-33: Trial balance worksheet for “Other Income”

To return to the previous worksheet, click the PTR TB tab (#1 in Figure 2-33) or click 
the Click to return to TB button above the worksheet tabs (#2 in Figure 2-33). Note 
that a detail tab (the “Other Income Detail” tab, #3 in Figure 2-33) might include one 
or more detail worksheets. 

Totals Totals are displayed at the bottom of each worksheet. If credit and debit columns are 
out of balance, the worksheet highlights the out-of-balance amount (Figure 2-31 on 
page 74).

In addition to credit and debit totals, the main trial balance worksheet shows the net 
income (loss) to be calculated for line 1 of Schedule M-1 after all entries and adjust-
ments are made in the software.

NOTE Do not create detail worksheets in data entry of Drake Tax if the 
trial balance worksheet does not provide an equivalent detail 
worksheet or the trial balance will not be imported correctly.

NOTE The data cannot be imported into Drake Tax if the worksheet is out 
of balance.
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SAVING A FILE

To save a file, click the Save icon or select File > Save from the menu bar. (In Excel 
2007 and 2010, click the Office button in the upper-left corner and select Save. In 
Excel 2013, click the File tab then Save.) To re-name a file when saving, select File > 
Save As. Trial balance templates are saved in the “TB” folder of your Drake Tax ’18 
program.

IMPORTING DATA INTO A RETURN

Once a trial balance worksheet has been set up for a client in Drake Tax, the trial bal-
ance information can be imported into the program and calculated into the return.

To import a trial balance into a return:

1. Open the return to which you will import the trial balance information.
2. Click Import > Trial Balance Import from the menu toolbar. The preliminary 

Trial Balance Import dialog box is opened.
3. Click Next.
4. Enter or select the trial balance file to be imported. Use the Browse feature if 

necessary. By default, each trial balance file is an Excel (.xls) file displaying the cli-
ent’s name and ending in “TB” for trial balance, as shown in the example in 
Figure 2-34. (See “File Location” on page 73.)

Figure 2-34: Selected file to import

5. Select the Trial Balance Additional Import Options. (See “Additional 
Import Options” following this procedure.)

6. Click Next and wait for the import to be completed.
7. Click Finish.

The program returns to the Data Entry Menu for the open return. Note that all 
selected data from the trial balance worksheet has been imported into the return. This 
can be seen both in the data entry screens and on the generated return.

NOTES
Not all trial balance data can be imported directly into a return. 
For information on program limitations, see “Special Conditions” 
on page 77.

If you are already in the Trial Balance Import tool for the selected 
return, go to the Trial Balance Import window in Drake Tax and 
start at Step 3 of the following procedure.
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Additional 
Import 
Options

By default, the program imports the following additional information when importing 
the trial balance data. Select the items to import or click Select All then click Next:

SPECIAL CONDITIONS

Some trial balance items cannot be entered into the trial balance worksheet and must 
be typed directly into Drake Tax data entry. Other items should be entered into the 
worksheet for balance purposes but do not flow to data entry; these must be entered 
separately and the calculated results compared to the trial balance worksheet.

Details for 
Preparers

Most trial balance items are imported directly to the location indicated in the program 
and on the return. For example, the amounts shown in Figure 2-35 go to Schedule L, 
line 1, column d, in the program and are shown on page 5, line 1, column d of the 1065 
return.

Figure 2-35: Indication of where an amount will go in Drake Tax and on the return

The “Other Information” column in the trial balance worksheet indicates special con-
ditions and additional information regarding certain rows. Table 2-5 describes the 
most common notes in this column.

Buildings and other depreciable assets Accumulated depreciation

Goodwill and other intangible assets Land

8825/Rent information Accumulated amortization

COGS depreciation

Table 2-5: “Other Information” Column Notes

Note Description

not included in totals The amount is required for importing purposes only but is 
not included in the totals shown on the trial balance.

does not import Information cannot be imported and must be entered on the 
appropriate screen in Drake Tax. Screen is specified in the 
“Reported on” column to the left of “Other Information.”

optional Amount is optional; not required for import, but could require 
direct entry in the program.
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All “does not import” notes are accompanied by further instructions in the “Reported 
on” column to the left of the “Other Information” column, as shown in Figure 2-36.

SCH2 Detail Typically, a balance sheet subsidiary schedule (SCH2 detail screen for Schedule L) is 
required for an item marked “does not import” on the trial balance. (Figure 2-36)

Figure 2-36: SCH2 screen required for “does not import” items

To complete an SCH2 detail screen in the tax program:

Screen code: 
SCH2

1. Open the SCH2 screen for the return.
2. Select the line number from Select line number from drop list.
3. Enter the applicable item descriptions and beginning- and end-of-year totals.

To enter details for additional lines of Schedule L, press PAGE DOWN and repeat steps 
2 and 3. Data is saved automatically upon entry.

When the return is produced, Schedule L of the return reflects both the amounts 
imported from the trial balance worksheet and the totals of the amounts entered on the 
SCH2 screens.

Depreciation Partnership (1065) returns can have up to four components of total depreciation:

• COGS 

• Real estate rental

• Rental other than real estate

• Any remaining depreciation

For trial balance purposes, enter depreciation amounts directly into the appropriate 
fields on the trial balance worksheet. Note that rental expense detail worksheets are 
required for 8825 and RENT depreciation.

enter as negative number Some deficits must be entered as negative numbers.

import includes the calculated 
change in inventory

Used for “total purchases”; when calculating cost of goods 
sold (COGS) in the return, the program takes the change in 
inventory into account for the Schedule A calculation.

Table 2-5: “Other Information” Column Notes

Note Description
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When the trial balance is imported, the COGS depreciation expense amount flows 
directly to the appropriate line of Schedule A on the return, and the rental depreciation 
expense amounts flow directly to the appropriate lines of the 8825 and RENT screens, 
as applicable.

Because the remaining depreciation can 
comprise any number of assets, the 
amount entered on the trial balance does 
not flow to the return. To ensure that 
each component of the total remaining 
depreciation is calculated into the 
return, each asset must be entered on the 
applicable depreciation screens in data entry (figure above). Enter depreciable asset 
data on a 4562 detail screen, or enter the total depreciation on the override screens.

Rental 
Expenses

The following information applies only for partnerships with multiple rental proper-
ties.

The partnership trial balances include lines for rental income and expenses (Figure 2-
37). Both rental expense items require a trial balance detail worksheet.

Figure 2-37: Rental expense rows on a trial balance worksheet

When imported, the rental expense data entered on the trial balance worksheet appears 
on either the 8825 screen (if real estate rental) or the RENT screen (if rental other than 
real estate).

Because the trial balance worksheet has only one detail screen per rental type, the 
importing function does not accommodate entities with multiple rental properties or 
expenses; however, the following procedure allows the trial balance to remain in bal-
ance if there are multiple rental properties or expenses.

NOTE
Enter 8825 and RENT depreciation amounts in the detail work‐
sheets for importing purposes, but be aware that the 8825 and 
RENT screens in the program will need to be edited if 4562 detail 
screens (see Figure ) are used.

NOTE

Entering the remainder of the depreciation on the trial balance 
worksheet helps ensure that the balance sheet balances and pro‐
vides a way to check that the amount on line 1 of Schedule M‐1 is 
correct. Compare the calculated line 1 amount at the bottom of the 
trial balance to the equivalent line on Schedule M‐1 of the calcu‐
lated return. If the depreciation amounts match but the line 1 
amounts differ, an M‐1 adjustment could be required.
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To accommodate entities with multiple rental properties or expenses:

1. Calculate the totals for both types of rental expenses.
2. Enter the income totals on the trial balance sheet and the expense totals on the 

applicable detail sheets (Figure 2-37 on page 79).
3. Ensure that the balance sheet is in balance.
4. Import the trial balance worksheet into the return. The applicable screens in data 

entry now contain the figures entered on the trial balance worksheet.
5. Compare the M-1, line 1, amount on the trial balance to the M-1, line 1, amount on 

the calculated return to ensure that they match.

6. Complete all 8825 or RENT screens in data entry, as applicable, for the individ-
ual rental properties or items.

7. Delete the 8825 and RENT screens that were imported from the trial balance 
(the screens reflecting the total rental expenses).

FORM 3115, APPLICATION FOR CHANGE IN ACCOUNTING METHOD

Form 3115, Application for Change in Accounting Method, is an application to the 
IRS to change either an entity’s overall accounting method or the accounting treat-
ment of any item. Drake Tax customers can fill out and e-file Forms 3115 and related 
schedules and attachments for partnership returns.

NOTE If the amounts do not match, review the imported amounts to 
ensure that all data was imported. If the data appears to have been 
imported correctly, an M‐1 adjustment could be necessary.

NOTE To delete a screen in data entry, open the screen and press CTRL+D. 
If a multiple forms list appears, be sure that the screen to delete is 
selected, then click Delete.

NOTES
In some cases, Form 3115 must still be paper‐filed.

Applicants filing Form 3115 should refer to Rev Proc. 2015‐13 
for general automatic change procedures, and to Rev Proc. 
2015‐14 for a list of automatic changes to which the automatic 
change procedures in Rev. Proc. 2015‐13 apply.
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ACCESSING SCREENS FOR CHANGING ACCOUNTING METHOD

Several screens may be required to 
complete Form 3115. These screens 
are accessible from the Change in 
Accounting Method box, located 
under the first Other Forms tab of the 
Data Entry Menu (figure at right). 
The screens accessible from the 
Change in Accounting Method sec-
tion include:

• Screen 3115 (Change in Account-
ing Method) — Used to access 
fields for Form 3115, including 
Schedules A through D

• Screen 311E (Schedule E) — Used to request a change in depreciation or amorti-
zation methods

• Screen ATT (Explanations and Attachments) — Used to create and view certain 
attachments to be generated by the software

• Screen ATT2 (Pt II Ln 12 & Pt III Ln 23b Attachment) — Used to complete 
certain parts of Form 3115 that require specific attachments

When you open screen 3115, the program displays the first of six tabbed screens. As 
shown in Figure 2-38, you can access the various 3115 screens by clicking a tabbed 
link at the top of any of the 3115 screens.

Figure 2-38: Tab links on 3115 screen

Multi-form 
Codes

All 3115 and related screens contain a Multi-form code text box (shown in Figure 2-
38) that allows you to link a screen or attachment to a particular Form 3115.

If submitting more than one Form 3115, assign a multi-form code to each new appli-
cation you create in Drake Tax. The first should be “1,” the second “2,” and so on. 
When using other screens, such as the 311E or ATT screens, you can use those num-
bers to indicate which instance of Form 3115 the 311E or ATT screen should be asso-
ciated with.

NOTE If only one Form 3115 is being submitted, you do not need to enter 
anything in the Multi‐form code box.
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Notices of 
Missing 
Attachments

In addition to Form 3115 and related schedules and statements, the program produces 
EF Messages (as applicable) when the return is calculated. All forms, schedules, EF 
Messages, and worksheets are accessible from View/Print mode.

EF Messages for Form 3115 provide information about required attachments (includ-
ing PDF attachments) that are missing from the return. Some messages list all state-
ments required for a particular section but do not indicate which statements, 
specifically, are missing. To best understand which attachments are still required, 
compare the ATT screen to the list of EF Messages in View/Print mode.

EF “ACK” PAGE

Similar to federal Form 9325, Acknowledgment and General Information for Taxpay-
ers who File Returns Electronically, generated with 1040 returns, the federal and state 
Partnership packages now generate an “EF_ACK” page for the main forms of federal 
returns and “(ST)EF_ACK” page for the main forms of state returns.

This is a Drake Tax-generated form that serves the same purpose as Form 9325: an 
acknowledgment that a return has been transmitted through Drake Tax and received 
by the IRS or the applicable state agency.

When a return is e-filed and you receive a “P” ack (indicating that the return is being 
processed) or an “R” ack (for a rejected return), the top section of the EF ACK page is 
completed, noting the name and address of the client, the return type, the ERO who 
transmitted the return), and a check box indicating the return was received by the IRS 
or applicable state agency.

When the return has been accepted—when you download and process your acknowl-
edgments and receive an “A” ack—the second section of the EF ACK is generated, 
indicating the return was accepted by the IRS or state agency and the date the return 
was accepted. The submission ID number is also included.

TIP
See Screen Help (accessible from the 3115 screen toolbar, from the 
right‐click menu, or by pressing CTRL+ATL+?) to access the Form 
3115 instructions through the IRS website.

NOTE All EF Messages must be eliminated before the return is eligible for 
e‐file. EF Messages for Form 3115 attachments are eliminated 
when all required statements have been attached to the return.
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Appendix A: Trial Balance Import

The trial balance import allows data to be imported into a partnership tax return from a 
trial balance worksheet.

Drake Tax’s specially designed trial balance template and importing function has the 
following benefits:

• Eliminates the need to duplicate entries

• Eliminates data entry errors by automatically importing data to the correct fields

• Allows preparers to merge basic accounting functions with tax preparation

See the next page for a flow chart describing the use of the trial balance import.
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Trial Balance Import: General Process
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Index 

Numerics
52-53-week year returns 66

A
accounting method

changing 67, 80
entering on 1065 14

accrual (accounting method) 14
address

entering on Form 1065 13
foreign 43
on K-1 letter heading 48
out-of-state 31

adjusted basis worksheet 44, 46–47, 63
adjustments

depreciation 54
to income and expenses 59

aggregation 36
multiple 37

allocations
section 754 47
special (screen SA) 43, 47

amending
a 1065 return 14, 24
and TEFRA audit rules 24
K-1 letters 48

amortization 21, 22, 51
analysis

of capital accounts (Schedule M-2) 52
APPT screen, see Multi-State Apportionment
asterisks (on K-1 codes) 43
attachments

binary 68–70
to Form 3115 80

autobalance 52, 64

B
bad debts 16, 18
bankruptcy returns, e-filing not allowed for 65
basis 46–47

see also adjusted basis worksheet
book-to-tax differences (Schedule M-1) 53–55
business activity codes 14

C
calendar year returns 13, 22
cash (accounting method) 14, 18
Centralized Partnership Audit Regime

electing out 28
Change in Accounting Method 80–82
Changes for 2018 10
Client Communications Editor (for letters) 48
codes

business activity 14
error/reject 67
K-1 42, 63
miscellaneous (screen 1) 31
multi-form 57, 81

compensation of partners 17
contact information (for state returns) 29
control number 41
cost of goods sold, see  Schedule A (Cost of Goods Sold)
cover letters (K-1) 48
coversheets 64
credits 16, 22, 59
Ctrl+W (detail) worksheets 15, 16, 72

D
data entry

for state information 29
importing trial balance into 71–80
state tabs in 29

dates
business start 14
tax year 13

deductions 17–22
depletion 21

oil and gas 38
depreciation

entering 19–21
for cost of goods sold (Schedule A) 15
of rentals 19, 57
on short-year returns 14
printing Form 4562 63
trial balance (business returns only) 78

detail (Ctrl+W) worksheets 15, 16, 72
Doing Business As 13
domestic production activities deduction 47
due dates 22
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E
EF_ACK page 82
e-filing 65

Form 8879-PE 23
Elections

Safe Harbor 61
electronic signatures (PIN) 23
employee benefit plans 21
envelope coversheets 64
error codes 67
expenses 17–22
exporting K-1 data 44
extensions 22, 64

F
Family Medical Act credit 11
farm profit or loss 16
filing instructions 64
final return 14
fiscal year returns 13
force print

end-of-year totals 51
foreign

addresses for partners 43
transactions 38

Form 3115 (Application for Change in Accounting Meth-
od) 67, 80–82

Form 4562 (Depreciation and Amortization) 57, 63
Form 4797 (Sales of Business Property) 16
Form 5884 (Work Opportunity Credit) 60
Form 6478 (Alcohol and Cellulosic Biofuel Fuels Credit)

60
Form 6478 (Biofuel Producer Credit) 16, 60
Form 6765 (Credit for Increasing Research Activities) 22, 

60
Form 7004 (Application for Automatic Extension of Time 

to File) 22
Form 8082 (Notice of Inconsistent Treatment or Amended 

Return) 24
Form 8820 (Orphan Drug Credit) 22, 60
Form 8825 (Rental Real Estate Income and Expenses of a 

Partnership or an S Corporation) 56–59
Form 8825 (Rental Real Estate) 58
Form 8832, Entity Classification Election 11
Form 8844 (Empowerment Zone Employment Credit) 60
Form 8845 (Indian Employment Credit) 60
Form 8846 (Credit for Employer Social Security and Medi-

care Taxes Paid on Certain Employee Tips) 18, 60
Form 8864 (Biodiesel and Renewable Diesel Fuels Credit)

60
Form 8864 (Biodiesel Fuels Credit) 16
Form 8873 (Extraterritorial Income Exclusion) 22
Form 8879-PE (IRS e-file Signature Authorization for 

Form 1065) 23
Form 8881 (Credit for Small Employer Pension Plan Start-

up Costs) 60
Form 8912 (Credit to Holders of Tax Bonds) 60
Form 8912 (Credit to Holders of Tax Credit Bonds) 60
Form 8916A (Supplemental Attachment to Schedule M-3)

56
Form 8941 (Credit for Small Employer Health Insurance 

Premiums) 60
Form 8941 (Credit for Small Employer Health-Insurance 

Premiums) 22
Form 8990, Limitation on Business Interest Expense Under 

Section 163(j) 10
Form 8994, Employer Credit for Paid Family and Medical 

Leave 11
Form 965, Inclusion of Deferred Foreign Income Upon 

Transition to Participation Exemption System 11
Form T (Forest Activities Schedules) 21

G
gains and losses 16
GILTI 11
Global Intangible Low-Taxed Income 11
grid data entry 42
gross receipts 15
guaranteed payments 17

H
header information 12
health insurance 22
health savings account (HSA) 17

I
importing trial balance 71–80
inactive returns 67
income 14–16
instructions for filing 64
insurance

and contributions to benefit plans 21
proceeds, income from 16

interest
expense 18
income 16
ownership of (Schedule B) 25–29
self-charged 19

inventory (on Schedule A, Cost of Goods Sold) 15
IRAs 21
Item M (on Schedule K-1) 46

K
K-1 codes 42
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K-1 cover letter 47–49
K-1 export 44
K-1, Schedule for 1065 39–46

L
letters (K-1) 48

M
M, item (on Schedule K-1) 46
maintenance costs 18
medical care for employees 22
Multi-State Apportionment 29

N
name control reject 68
net

farm profit or loss 16
gain or loss 16

next-year depreciation listing 63
number of partners 14

O
oil and gas depletion 38
ordinary gains and losses 16
other

costs (Schedule A) 15
deductions 22
income (loss) 16

overrides
of calculations for partners 43
on screen 1 31

ownership
changes 43
of interest (Schedule B) 25

P
partners

compensation of 17
foreign addresses for 43
guaranteed payments to 17
health insurance 17
returns with numerous 43
rounding 40
Schedule K-1 39
special allocations for 47
updating data annually 47

payments, guaranteed 17
PBAN fields. 36
PDF attachments 68
PIN (electronic) signatures 23

principal business activity 14
principal product or service 14
printing

1065 returns 62
adjusted basis worksheets 63
cover letter for K-1 48
force 62
K-1 items 43
suppressing/forcing documents 62

prior-year returns, updating 12

Q
Qualified Business Income

aggregation 36
Qualified Business Income (QBI) 34

R
real estate 78
receipts 15
refunds, state 16
reject codes 67
rent paid on business property 18
rental activities 56–59
repair costs 18
resident state 29, 31
retirement plans 21
returns

52-53-week year 66
bankruptcy 65
extensions for 22
fiscal and calendar year 13
inactive 67
short-year 13
signing 23
updating prior-year 12

rounding partner 40
royalties worksheet 59

S
SA screen 32
Safe Harbor Elections 61
scanning attachments for e-filing 68
Schedule A (Cost of Goods Sold) 15–16
Schedule B (Other Information) 25
Schedule B-1 (Information on Partners Owning 50%) 26
Schedule K (Partners’ Distributive Share Items) 31–39
Schedule K-1

grid data entry 42
Partner Information 39–46
Supplemental information 45

Schedule K-1 (Share of Income, Deductions, Credits, etc.)
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sorting business K-1s 40
Schedule L (Balance Sheet per Books) 49–52, 62
Schedule M-1

adjustments 52
Reconciliation of Books 53
Reconciliation of Books With Return 62

Schedule M-2 (Analysis of Capital Accounts) 52
Schedule M-3

force printing 55
Schedule M-3 (Net Income (Loss) Reconciliation) 53, 55
section

179 21, 47
481 16
754 20, 47

Section 199A items 36
security

business packages 64
security screen 64
self-employment income 59
SEP or SIMPLE plans 21
short-year returns 13
signatures, electronic 23
signs return partner 23, 40, 48
special allocations 32
special allocations (screen SA) 43, 47
Specified service trades or businesses 35
state

overriding information related to 31
resident 29
tabs in data entry 29
tax refunds 16

statements 51
elections 61
Schedule L 51
Schedule M-3 56

state-specific information 29

T
tax

years (fiscal vs calendar) 13
Tax and Payment section 11
Tax Equity and Fiscal Responsibility Act (TEFRA) 24
Tax Matters Partner 27
Tax screen 11
taxes and licenses 18
trial balance import

and depreciation 15
and SCH2 screens 52
instructions for using 71–80

U
updating

a prior-year return 12
partner data annually 47

W
wages 17
What’s New for 2018 9

Y
Year screen 13
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